


·warranty 
Limited warranty on Media 

Hearlihy & co . warrants the disks on which the Software is recorded to be free from defects In materials and 
faulty workmanship under normal use for a period of ninety (90) days from the date of delivery as evidenced by 
a copy of the sales rec~ipt. Heariihy & Co. will, at ~s op.tion, replace or refund the purchase price of the disk at 
no charge to you, provided y.ou return the faulty disk with the sales receipt to Hearlihy & co . or an authorized 
Hearlihy & Co. Dealer. Hearl1hy & Co. shall have no responsibility to replace or refund the purchase price of a 
disk damaged by accident, abuse or misapplication. 

Disclaimer of Warranty on Software 

The software is pr?vid~d "as. is" without w~rranty of a.ny k!nd, and N~OTEK Software, Inc. expressly disclaims 
all Implied warranties, including but not limited to the 1mphed warranties of merchantability and fitness for a 
particular purpose. NEOTEK Software, Inc. does not warrant, guarantee, or make any representations 
regarding the use or the results of the use of the Software or any accompanying written materials in terms of 
their correctness, accuracy, reliability, currentness, or otherwise. The entire risk as to the results and 
performance of the software and written materials is assumed by you. NEOTEK Software, Inc. does not 
warrant that the software will work correctly in your multi-user environment. If the software is defective, you, 
and not NEOTEK Software, Inc. or its dealers, distributors, agents, or employees, assume the entire cost of all 
necessary servicing, repair, or correction. Some states do not allow the exclusion of implied warranties, so the 
above exclusion may not apply to you. 

Complete Statement of Warranty 

The limited warranties provided in the paragraphs above are the only warranties of any kind that are made by 
NEOTEK Software, Inc. on this NEOTEK Software, Inc. product. No oral or written information or advice given 
by NEOTEK Software, Inc., its dealers, distributors, agents, or employees shall create a warranty or in any way 
increase the scope of this warranty, and you may not rely on any such information or advice. This warranty 
gives you specific legal rights. You may have other rights, which vary from state to state. 

Return Policy 

All discoverCAD software, except Site Licenses., may be returned within 30 days of date of purchase for 
exchange, cash, or credit when purchased direct from Heariihy & Co. (send invoice copy as proof of 
purchase). After 30 days of date of purchase, but prior to 90 days, all discoverCAD software may be returned 
for exchange only at no extra charge. All software returned after 90 days will be replaced for a minimal 
duplicating and handling fee of $10.00 per disk. Please return your original disk and check or purchase order. 
All returns should be shipped to the following address and must include complete shipping instructions: 

discoverCAD Return 
Hearlihy & Co. 

714 W. Columbia St. 
Springfield, Ohio 45501 

*discoverCAD Site License software is sold on a "Final Sale" basis but may be returned for exchange, no 
charge, at anytime. Please send original disks only and invoice copy (as proof of purchase) to the above 
address. 



Copyright and Trademark 

discoverCAD is the trademark of NEOTEK Software, Inc., and the use of it is prohibited without prior written 
consent. 

Apple, IIC, IIE, IIGS, AppleMouse, Extended SO-Column Text Card, Super Serial Card, 410 Graphics Plotter 
are trademarks of Apple Computer, Inc. 

Roland, DXV 880, DXV 980, DXY 1100 ar& trademarks of the Roland D G Corporation. 

Houston Instrument, HI, PC695, PC695A, PC595, DMP40, DMP41 are trademarks of AMETEK, Inc. 

Hewlett Packard, HP, HP7470, HP7475 are trademarks of Hewlett Packard Co. 

Unlawful Software Dupllcatlon 

NEOTEK Software, Inc. Software and User's Guide are protected under copyright law. Unlawfully copying, 
duplicating, selling or otherwise distributing these products is hereby expressly forbidden. 

discoverCAD is copy-protected. Any attempt to make an unauthorized copy may result in damage to the 
original disk, thereby waiving the Limited Warranty on Media above. A backup set of the software has been 
included for your convenience. 

Backups, CADPAKs (quantity discounts), and site license agreements are available from Hearlihy & Co. (see 
the Hearlihy catalog). 

Software Compatlblllty 

Drawing files created with the original discoverCAD, discoverCAD II, or any subsequent upgrades and/or 
updates are not compatible between each other, and may result in unreliable or unpredictable results when 
used in such a manner. 

Technical Suppon 

Customer service is available on a first come, first serve basis. Hearlihy & Co. has a staff of trained Service 
Reps. who will be only too happy to help. However, we do request that you check the manual in its entirety 
before you call. Help is available 9:00AM - 5:00PM EST at 1.800.622.1000. 

Bugs 

Each version of discoverCAD is thoroughly reviewed and tested before its release; however, should you 
encounter a system error or bug, please note the error message generated by the software as well as the 
command for which it was issued, and contact the Technical Support staff. 
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Chapter 1 
INTRODUCTION 

Welcome! discoverCAD is a powerful Computer Aided Design (CAD) tool for creating structured graphics : 
architectural, electrical, and mechanical drawings , and much more . With dlscoverCAD , it's easy to create 
precise, complex drawings and even easier to change and modify what you create. Some of you are computer 
whizzes, some are complete novices. Either way, the software and manual are designed to get you up and 
running as painlessly as possible. 

The discoverCAD software has ten menus, each menu containing a logical grouping of commands. 
discoverCAD's menus are organized from left to right in the menu bar as follows: 

The Apple menu contains any miscellaneous commands that can be used to manipulate discoverCAD's 
default values used during the course of a drawing session. 

The File menu contains any commands that pertain to the disk operations or basic utilities of discoverCAD 
(ex. saving a drawing to a floppy disk). 

The Screen menu contains any commands that pertain to the positioning or scaling of your drawing. Also 
included in this menu are the grid and layer commands. 

The Entity menu contains any commands that pertain to the creation of the basic entities of a drawing such 
as lines, circles, arcs, and points (entity is a general term for an individual line, circle, arc, point, etc.). Also 
included in this menu are the commands necessary to erase such entities. 

The <·Modify menu contains any modifiers that pertain to the Draw Line, Draw Rectangle, Draw 
Circle, Draw Arc, and Draw Point commands in the Entity menu. Please note that there are two 
<-Modify menus; this particular menu contains all the modifiers relating to the Entity menu. 

The Text & Dimension menu contains any commands that pertain to the creation of text and dimensioning. 
Text may be any notes or messages you might add to your drawing such as a name, date, description, etc. 
Dimensioning is a process that calculates the length of a line, the radius of a circle or arc, or the diameter of a 
circle or arc, and automatically draws the correct dimension lines, extension lines, arrowheads, and dimension 
text. Also included in this menu are the commands necessary to erase such entities. 

The <-Modify menu contains any modifiers that pertain to the Draw Linear Dim, Draw Radial Dim, 
Draw Diameter Dim, and Draw Text commands in the Text & Dimension menu. Please note that there 
are two <-Modify menus; this particular menu contains all the modifiers relating to the Text & Dimension 
menu. 

The Edit menu contains any commands that pertain to the alteration or replication of any basic entity (i.e. line, 
circle, arc, or point). By using the commands found in this menu, you will be able to save time utilizing graphic 
manipulation to duplicate and reposition drawing entities. 
The Mask menu contains any masks that are used to limit selection during coordinate specification (i.e. . 
clicking) to a particular area of the screen, position on the end of an existing entity (i.e. line, circle, arc, or point), 
or position in the center of an existing entity. Masks will work with practically any command that req~ires you to 
specify a coordinate or coordinates. Also included in this chapter are the masks necessary to specify 
coordinates using the Cartesian or polar coordinate systems. 

The Plot menu contains any commands that pertain to the output of your drawing. 
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The discoverCAD manual is organized just like the software as described above, with a chapter for each menu. 
Each chapter contains an explanation of every command found in the menu, along with the operation, 
parameters, default value, and errors associated with each command. Also included in the manual are the 
Draw Tutorial, Symbol Tutorial, Print Tutorial, and Plot Tutorlal appendices, which are detailed 
examples of various discoverCAD operations . Last you will find the Helpful Hints and Tec hnical Notes 
appendices, which are a collection of suggestions and solutions to various questions and problems that 
pertain to the various functions of discoverCAD. Beginners should complete this introduction, then move on 
to the Draw Tutorials to familiarize themselves with the basics of discoverCAD . Experts will want to use this 
manual as a reference guide to any discoverCAD commands that they are unfamiliar with, or do not know how 
to use correctly. The tutorials will also be of use to the expert, as they are loaded with useful techniques. 
Whether beginner or expert, we hope you enjoy your experience with discoverCAD . 

After you have completed this chapter, you will be able to configure your computer for discoverCAD, startup 
the software, use the mouse, menus, and keyboard. Also included in this chapter are the commands found in 
the Apple menu, which are used to manipulate discoverCAD's default values used during the course of a 
drawing session. 

Hardware Setup 

In order to use discoverCAD on your Apple IIC, IIE, or IIGS, you must first configure your hardware. In all cases, 
discoverCAD requires a minimum of 128K RAM, the AppleMouse, a monochrome monitor (discoverCAD will 
work on a color monitor, however, it does not currently display in color), and two 5.25" disk drives , or one 3.5" 
disk drive and one 5.25" disk drive. 

Apple !IC: 1) Connect the AppleMouse to the mouse port on the back of the computer. 
2) Plug the monitor cable into the monitor jack on the back of the computer. 
3) Connect the external 5.25" disk drive to the drive port on the back of the computer . If you are having 
difficulty configuring your computer, see the Apple IIC Owner's Guide for more on installation. 

Apple UE: 1) If your IIE does not have the 128K RAM required by discoverCAD (the newer IIE has 128K, the 
older one does not), install the Apple Extended BO-Column Text Card in the Auxiliary slot (make sure the 
Double Hi Res Jumper Block is in place). 
2) Install the AppleMouse IIE card in slot 4 or 5 of the computer. 
3) Connect the AppleMouse to the mouse card port on the back of the computer. 
4) Plug the monitor cable into the monitor jack on the back of the computer . 
5) Connect the first external 5.25" disk drive (or first external 3.5" disk drive) to the disk controller card installed 
in slot 6 of the computer . 
6) Connect the second external 5.25" disk drive to the drive port on the back of the first external disk drive. If 
you plan to use more than two disk drives, simply continue to link, or "daisy chain" them together. If you are 
having difficulty configuring your computer, see the Apple IIE Owner's Guide for more on installation . 

Apple IIGS; 1) Connect the AppleMouse to the mouse port on the back of the computer. 
2) Plug the monitor cable into the monitor jack on the back of the computer. · 
3) Connect the first external 5.25" disk drive (or first external 3.5" disk drive) to the drive port on the back of the 
computer. 
4) Connect the second external 5.25" disk drive (or second external 3.5" disk drive) to the drive port on the 
back of the first external disk drive. If you plan to use more than two disk drives, simply continue to link, or 
"daisy chain" them together. 
5) Reconfigure the IIGS display via the Desk Accessories firmware. To get the Desk Accessories Program, 
press the Control , Open Apple , and Escape keys simultaneously. Press the Up Arrow or Down Arrow to 
highlight the Control Panel option, then press Return. Press the Up Arrow or Down Arrow to highlight the 
Display option , then press Return. Press the Up Arrow or Down Arrow to highlight the Type option, then press 
the Right Arrow or the Left Arrow to change it to Monochrome . 
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Press Return to save the configuration, then Quit the Control Panel and Desk Accessories menus. The IIGS 
will remember this configuration in all subsequent sessions. If you are having difficulty configuring your 
computer, see the Apple IIGS Owner's Guide for more on installation. 

Getting Started 

Having configured your Apple system per the instructions above, you are now ready to start a session with 
discoverCAD. Before you start, it is important to remember that the discoverCAD system disks must remain in 
the disk drives at all times . 

Apple UC and HE; Always use the 1st disk drive (or any other drives connected besides the 2nd disk drive) for 
the FIie commands such as Format, Directory, save , Edit, and Merge, and keep the 5.25" 
discoverCAD System Disk 2 in the 2nd disk drive at all times. 

Apple UGS: Always use the 2nd disk drive (or any other drives connected besides the 1st disk drive) for the 
FIie commands such as Format, Directory, Save, Edit, and Merge, and keep the 3.5" discoverCAD 
System Disk in the 1st disk drive at all times. 

Usually you will want to specify the drive to be used for the File commands before starting your drawing by 
using the Drive command as described in the FIie Menu chapter. Should your IIC, IIE, or IIGS be equipped 
with more than two disk drives, you may also use the Drive command to access the additional drives . In 
general, never remove the discoverCAD system disks unless prompted to do so by the system, and never try 
to Save a drawing to the system disks. Also, please note that you should never write protect your 
discoverCAD system disks; you may receive a error message. If this happens, remove the write protection 
from the disk and reboot the system. Also, make sure the Caps Lock key is depressed during your session 
with discoverCAD. Finally, when booting the discoverCAD system, make sure that the discoverCAD system 
disks are the only ones present; if there are other disks on line, the system may get confused and try to boot 
off the foreign disk. 

3,5" disk drive users: If your system configuration consists of a 3.5" disk drive as the first drive, and either a 
3.5" or 5.25" disk drive as the second, place the 3.5" discoverCAD System Disk in the first drive and turn on 
the power switch. After approximately 45 seconds the discoverCAD Menu Bar will appear on screen. At this 
time, you may want to configure discoverCAD to recognize a disk drive other than the first disk drive as the disk 
drive to be used for all FIie commands (see the Drive command in the FIie Menu chapter to specify your 
data drive). 

5,25" disk drive users: If your system configuration consists of a 5.25" disk drive as the first drive, and a 5.25" 
disk drive as the second, place the 5.25" discoverCAD System Disk 1 in the first drive, and the 5.25" 
discoverCAD System Disk 2 in the second drive, and tum on the power switch. After approximately 45 
seconds the discoverCAD Menu Bar will appear on screen. 

Using the Mouse 

Having started the discoverCAD system per the instructions above, you are now ready to learn how to use the 
mouse. Try sliding the mouse around on a clean, flat surface next to your computer. When you move the 
mouse across your desk, notice how the small arrow, called the pointer, moves in a corresponding way across 
the screen. • 
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Using the Menus 

Now that you are familiar with the mouse, you are now ready to select a command from one of the pull-down 
menus. Use the mouse to position the arrow over the word Entity in the menu bar at the top of the screen. 
Now, press the mouse button down and hold it down. The contents of the Entity menu should now appear 
on screen. While still holding the mouse button down, slowly drag the mouse toward you until the command 
Draw Line is highlighted. Now release the mouse button to activate the Draw Line command (the disk 
drives will whirl momentarily while the command is being loaded). Simple enough? That's the way all 
discoverCAD commands will be executed! Next, click the mouse button once where you would like the line to 
begin (pressing and releasing the mouse button is called clicking). Click a second time where you would like 
the line to end, and a line will be drawn between the two points you clicked. Practice drawing a few lines to 
further familiarize yourself with the use of the mouse and pull-down menus. 

Using the Keyboard 

While it is strongly recommended that you use a mouse with discoverCAD, you may use the keyboard instead. 

Apple UC and UE: Press the Open Apple and Closed Apple keys simultaneously, then release only the Closed 
Apple key (this tells discoverCAD that you will be using the keyboard for all command and coordinate entry). 
Now you can use the directional arrow keys on the keyboard to position the mouse pointer on the screen 
(similar to moving the mouse), and the Closed Apple key to click (similar to clicking the mouse). Remember you 
must have the Open Apple key depressed at all times. Try drawing a line as described above in the mouse 
section, only substitute the mouse actions with the corresponding keyboard actions. Please note that it is 
necessary to release the Open Apple key when you are inserting text (see the Draw Text command in the 
Text & Dimension Menu chapter). 

Apple UGS; Follow the keyboard instructions as described above in the IIC and IIE users section, only 
substitute the Option key for the Closed Apple key. Please note that it is necessary to release the Open 
Apple key when you are inserting text (see the Draw Text command in the Text & Dimension Menu 
chapter). 
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APPLE MENU 

The Apple menu conta!ns any miscellaneous C?mmands that can be used to manipulate discoverCAD's 
default values ~s.ed durm~_the course of a d~awmg session. A default value is a value that is assumed to be 
equal to an existing cond1t1on unless otherwise stated (ex. the computer assumes you will be plotting from 
Slot 2 of your computer unless you tell it otherwise). . 

After you have completed this section, you will be able to use the Trace and Slot Number commands. 

Trace 

The Trace command is used to specify whether or not you want the arrow cursor to leave a dot at each 
coordinate clicked. 

Operatjon: Highlight the Trace command in the Apple menu, and release the mouse button. The tracing 
feature will now be in effect (when trace is on, the command will have a check mark next to it in the Apple 
menu}. To turn the trace off, simply reselect the Trace command. 

Parameters· On/Off. 

Default Value; Trace= Off. 

~None. 

Slot Number 

The Slot Number command is used to specify which slot you want to plot from, either Slot 1 or Slot 2. If you 
are using an Apple IIC or IIGS, you are actually specifying which port to use (see the Plot Tutorial appendix 
for more on setting the serial port). If you are using an Apple IIE, you are specifying which slot contains the 
serial card (slot 1 is used for printing, slot 2 is used for plotting). See the Plot Tutorial appendix for more on 
setting the serial card. 

Operation; Highlight the Slot Number command in the Apple menu, and release the mouse button. You 
will then be prompted "Slot Number (1,2):"; type which slot/port number you wish to plot from, and press 
Return. From now on discoverCAD will expect to find the plotter attached to the slot/port number you have 
specified. 

Parameters: Slot (integer 1 or 2). 

Default Value: Slot = 2. 

~ The system will continue to prompt you until a valid slot number is entered (i.e. 1 or 2). 
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Chapter 2 
FILE MENU 

The FIie menu contains any commands that pertain to the disk operations of discoverCAD (ex. saving a 
drawing to a floppy disk). Before you use any of the FIie commands, it is important to remember that the 
discoverCAD system disks must remain in the disk drives at all times. 

Apple UC and UE: Always use the 1st disk drive (or any other drives connected besides the 2nd disk drive) for 
the FIie commands such as Fonnat, Directory, Save, Edit, and Merge, and keep the 5.25" 
discoverCAD System Disk 2 in the 2nd disk drive at all times. 

Apple UGS: Always use the 2nd disk drive (or any other drives connected besides the 1st disk drive) for the 
FIie commands such as Fonnat, Directory, Save, Edit, and Merge, and keep the 3.5" discoverCAD 
System Disk in the 1st disk drive at all times. 

Usually you will want to specify the drive to be used for the FIie commands before starting your drawing by 
using the Drive command as described below. Should your IIC, IIE, or IIGS be equipped with more than two 
disk drives, you may also use the Drive command to access the additional drives. In general, never remove 
the discoverCAD system disks unless prompted to do so by the system, and never try to Save a drawing to 
the system disks. 

After you have completed this chapter, you will be able to use the Format, Directory, Save, Edit, Drive, 
Merge, and Symbol commands. 

Format 

The Format command must be used before you can save a drawing created with discoverCAD. If you are 
planning to save to a 5.25" disk drive, use a single-sided double-density 5.25" diskette. If you are planning to 
save to a 3.5" disk drive, use a double-sided double-density 3.5" diskette. Please note that once a disk has 
been formatted, it is not necessary to reformat the disk unless you wish to erase its entire contents. 

Operatjon: Highlight the Format command in the FIie menu, and release the mouse button. You will then be 
prompted "Place the disk to be formatted in drive #x:, then press RETURN." (where x represents the disk 
drive being used for the FIie Menu commands). Replace the discoverCAD system disk with the disk you 
wish to format, and press Return. If the disk you have inserted is new, the system will immediately begin to 
format. If the disk you have inserted has already been formatted, you will be prompted "WARNING: Wish to 
erase this disk? (Y/N)". If you type Y, the disk will be reformatted (and its contents erased). If you type N, the 
disk will not be formatted. When formatting is completed (approximately 25 seconds for a 5.25" disk, 45 
seconds for a 3.5" disk), you may be prompted "Replace discoverCAD system disk 1 in drive #1 :, then press 
RETURN.". Replace the newly formatted disk with the discoverCAD system disk you removed, and press 
Return to resume discoverCAD. 

Parameters: None. 

Default Value: Drive= 1 (can be changed using the Drive command). 

~ 1) If the discoverCAD system disk is inserted for formatting, you will be prompted "ERROR: Unable to 
format system disk. Press RETURN.". 
2) If no disk is inserted for formatting, you will be prompted "ERROR: Unable to format disk. Press RETURN." . 
3) If the disk inserted for formatting is write protected, you will be prompted "ERROR: Disk is write-protected. 
Press RETURN.". 
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4) If the discoverCAD system disk is not replaced after formatting, you will continue to be prompte~ "Replace 
discoverCAD system disk 1 in drive #1 :, then press RETURN." until the discoverCAD system disk 1s replaced. 

Directory 

The Directory command is used to obtain a directory listing of the drawing or symbol files you have stored on 
a floppy disk. Please note that it is advisable to use this command before you begin drawing, as it is necessary 
for the system to redraw the screen after this command has been executed, and, depending on the size of 
your drawing, could be time consuming. 

Qperatjon: Highlight the Directory command in the FIie menu, and release the mouse button. You will then 
be prompted "Place the desired disk in drive #x:, then press RETURN." (where x repn:3sents the disk drive 
being used for the FIie Menu commands). Replace the discoverCAD system disk with the disk you wish to 
obtain a directory listing from, and press Return. The contents of the disk you have inserted will now be listed 
on the screen. When the listing is completed, you may be prompted "Replace discoverCAD system disk 1 in 
drive #1 :, then press RETURN.". Replace the drawing disk with the dif;coverCAD system disk you removed, 
and press Return to resume discoverCAD. 

Parameters: None. 

Default Value· Drive= 1 (can be changed using the Drive command) . 

.E.a:.Qrs; 1) If no disk is inserted for listing, you will be prompted "ERROR: Disk error. Press RETURN.". 
2) If the disk inserted for listing is not formatted, you will be prompted "ERROR: Disk error. Press RETURN.". 
3) If the discoverCAD system disk is not replaced after listing, you will continue to be prompted "Replace 
discoverCAD system disk 1 in drive #1 :, then press RETURN." until the discoverCAD system disk is replaced. 

Save 

The Save command is used to store a drawing that you have created with discoverCAD onto a disk that has 
been formatted with discoverCAD. Please note that it is advisable to save your drawing every 15 minutes or so 
to prevent the loss of your work should the computer fail. Also, IIGS users should see the Drive command 
below before saving, as it is necessary to specify the drive where the drawing disk will be found (substitute 
drive #x: for drive #1: in the saving instructions listed below, where x represents the disk drive being used for 
the FIie Menu commands). 

Qperation: Highlight the Save command in the FIie menu, and release the mouse button. You will then be 
prompted "Place drawing disk in drive #x:, then press RETURN." (where x represents the disk drive being 
used for the FIie Menu commands). Insert a disk that has already been formatted using discoverCAD, and 
press Return. You will then be prompted "File name:". Type in a name for the drawing consisting of up to 8 
alpha and/or numeric characters (if you make a mistake while typing the filename, you may use the Delete or 
Left Arrow keys to remove the error). Now press Control Q to enter the filename (depress the Control and Q 
key at the same time). The drawing you currently have displayed on the screen will now be saved. Once the 
drawing has been saved, you may be prompted "Replace discoverCAD system disk 1 in drive #1 :, then press 
RETURN.". Replace the drawing disk with the discoverCAD system disk you removed, and press Return. 

Parameters· File name (up to B alpha and/or numeric characters). 

Default Value: Drive= 1 (can be changed using the Drive command). 

~ 1) If no file name Is given for the drawing (i.e. you press Control Q without specifying a file name), you 
may be prompted to replace the discoverCAD system disk. 
2) If you try to type the file name and nothing appears, make sure the Caps Lock key is depressed. 
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3) If the file name you specify is longer than B characters, the system will truncate it to a length of 8 characters. 
4) If no disk is inserted for s~ving, an error message will be issued. 
5) If the disk inserted for sav~ng ~s no~ formatted, an error message will be issued. 
6) If the disk inserted for sav!ng !s write prot~cted, an error message will be issued. 
7) If the disk inserted for savmg_1s f~II, you w,11 be prompted "ERROR: Disk full. Press RETURN.". 
B) If the discoverCAD ~yste~ dis~ 1s not replaced after saving, you will continue to be prompted "Replace 
discoverCAD system disk 1 m drive #1 :, then press RETURN." until the dlscoverCAD system disk is replaced. 

Edit 

The Edit command is used to retrieve a drawing that you have saved onto a disk that has been formatted with 
discoverCAD. Please note that IIGS users should see the Drive command below before editing, as it is 
necessary to specify the drive where the drawing disk will be found (substitute drive #x : for drive #1: in the 
editing instructions listed below, where x represents the disk drive being used for the FIie Menu 
commands). 

Qperatjon: Highlight the Edit command in the FIie menu, and release the mouse button. You will then be 
prompted "Place drawing disk in drive #x:, then press RETURN." (where x represents the disk drive being 
used for the File Menu commands). Insert the disk that contains the drawing you wish to retrieve, and press 
Return. You will then be prompted "File name:". Type in the name of the drawing (if you make a mistake while 
typing the filename, you may use the Delete or Left Arrow keys to remove the error) and press Control Q to 
enter the filename (depress the Control and a key at the same time). Once the drawing name has been 
specified, you may be prompted "Replace discoverCAD system disk 1 in drive #1 :, then press RETURN.". 
Replace the drawing disk with the discoverCAD system disk you may have removed, and press Return. The 
drawing will now be displayed on the screen, after which you can resume discoverCAD. If you can't remember 
the name of the drawing, use the Directory command to obtain a listing of the drawing disk. 

parameters: File name (up to B alpha and/or numeric characters). 

Default Value: Drive= 1 (can be changed using the Drive command). 

~ 1) If no file name is given for the drawing (i.e. you press Control Q without specifying a file name), you 
may be prompted to replace the discoverCAD system disk. 
2) If you try to type the file name and nothing appears, make sure the Caps Lock key is depressed. 
3) If the file name you specify is longer than B characters, the system will truncate it to a length of B characters. 
4) If no disk is inserted for editing, an error message will be issued. 
5) If the disk inserted for editing is not formatted, an error message will be issued. 
6) If the disk inserted for editing is empty, or the drawing name specified is not found on the disk, you will be 
prompted "ERROR: Drawing not found. Press RETURN.". 
7) If the discoverCAD system disk is not replaced after editing, you will continue to be prompted "Replace 
discoverCAD system disk 1 in drive #1 :, then press RETURN." until the discoverCAD system disk is replaced. 

Drive 

The Drive command is used to specify which disk drive to access for the Format, Directory, Save, Edit, 
and Merge commands. You will typically use this command to specify the 2nd disk drive as the primary drive 
When using discoverCAD on the IIGS, or to access any additional drives you may have connected to your IIC, 
IIE, or IIGS. Please note that you must keep the 3.5" discoverCAD system disk in drive one at all times if you 
are using a 3.5" disk drive as the startup drive. If you are using a 5.25" disk drive as the startup drive, you must 
keep the 5.25" discoverCAD system disk 2 in drive 2 at all times. 
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Operatjon: Highlight the Drive command in the FIie menu, and release the mouse button. You will then be 
prompted "Drive number (1,2,3,4,5,6):". discoverCAD assigns numbers to the disk drives connected to your 
IIC, IIE, or IIGS configuration as follows: 

#1 is the startup drive, attached to slot 4, 5, or 6. 
#2 is the 2nd drive, attached to the same slot as the startup drive. 
#3 is the 3rd drive, attached to slot 4, 5, or 6. 
#4 is the 4th drive, attached to the same slot as the 3rd drive. 
#5 is the 5th drive, attached to slot 4, 5, or 6. 
#6 is the 6th drive, attached to the same slot as the 5th drive. 

Type in the number of the disk drive you wish to access for the FIie commands, and press Return. Once a 
valid value for the drive number has been entered, discoverCAD will access that drive during the FIie 
commands for the remainder of your work session. 

Parameters; Drive (integer 1 - 6). 

Default Value; Drive = 1. 

~ 1) The system will continue to prompt you until a valid drive number is entered (i.e. 1 - 6). 
2) If the drive you have specified is not on line, you will be prompted "ERROR: Disk drive not on line. Press 
RETURN.". 

Merge 

The Merge command is used to attach a symbol file that has been previously created to a drawing that is 
currently being created or edited, thereby allowing you to later access a symbol layer (see the Symbol 
command below). Please note that IIGS users should see the Drive command above before merging, as it Is 
necessary to specify the drive where the symbol disk will be found (substitute drive #x : for drive #1: in the 
merging instructions listed below, where x represents the disk drive being used for the FIie Menu 
commands}. Also, please note that it is worthwhile to review the Symbo1I Tutorial appendix to take full 
advantage of this command. 

Operation; Highlight the Merge command in the FIie menu, and release the mouse button. You will then be 
prompted "Place drawing disk in drive #x :, then press RETURN." (where x represents the disk drive being 
used for the File Menu commands). Insert the disk that contains the symbol file you wish to retrieve, and 
press Return. You will then be prompted "File name:". Type in the name of the symbol file (if you make a 
mistake while typing the filename, you may use the Delete or Left Arrow keys to remove the error) and press 
Control Q to enter the filename (depress the Control and Q key at the same time). Once the symbol file has 
been specified, you may be prompted "Replace discoverCAD system disk 1 in drive #1 :, then press 
RETURN.". Replace the symbol disk with the discoverCAD system disk you may have removed, and press 
Return. The drawing you are currently creating or editing will now be redrawn on the screen, after which you 
can resume discoverCAD. The symbol file will not be displayed unless the layer(s) that contain(s) the symbol(s) 
are currently drawn on screen, or "echoed" (see the Screen Menu chapter for more on layers). If you can't 
remember the name of the symbol file, use the Directory command to obtain a listing of the symbol disk. 

Parameters; FIie name (up to 8 alpha and/or numeric characters). 

Default Value; Drive = 1 (can be changed using the Drive command). 

~ 1) If no file name is given for the symbol file (i.e. you press Control Q without specifying a file name), 
you may be prompted to replace the discoverCAD system disk. 
2) If you try to type the file name and nothing appears, make sure the Caps Lock key is depressed. 
3) If the file name you specify is longer tha.-i a characters, the system will truncate it to a length of a characters. 
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4) If no disk is inserted for merging, an error message will be issued. 
5) If the disk inserted for merging is not formatted, an error message will be issued. 
6) If the disk inserted for merging is empty, or the symbol file name specified is not found on the disk, an error 
message will be issued. 
7) If the discoverCAD system disk is not replaced after merging, you will continue to be prompted "Replace 
discoverCAD system disk 1 in drive #1 :, then press RETURN." until the discoverCAD system disk is replaced. 

Symbol 

The Symbol command is used to copy a symbol from another layer, or a symbol file that has already been 
merged to a drawing that is currently being created or edited (see the Merge command above). Please note 
that a symbol can be one entity or a group of several entities (i.e. lines, circles, arcs, points). However, this 
does not include text and dimensioning. A symbol must not contain text or dimensioning; any attempt to 
transfer such may result in unpredictable results. Also, please note that your workspace is limited to one 
screen full; you may Pan or Zoom to aid you when creating the symbols, however, you will only be able to view 
and retrieve the symbols visible with the screen at its original scaling and origin (i.e. Zoom Origin). Finally, 
please note that it is worthwhile to review the Symbol Tutorial appendix to take full advantage of this 
command. 

Operation: Highlight the Symbol command in the FIie menu, and release the mouse button. You will then be 
prompted "Copy symbol from layer number?"; type in the number of the layer that contains the symbol you 
wish to copy, and press Return (if you press Return without entering a value for the layer, the system will exit 
the Symbol command). Next, you will be prompted "Copy symbol to layer number?"; type in the number of 
the layer that you wish to copy the symbol to (typically your drawing layer), and press Return (again, if you 
press Return without entering a value for the layer, the system will exit the Symbol command). Finally, you will 
be prompted "Symbol Scaling?"; type in the desired scale of the symbol in relationship to the drawing (ex. if 
you want the symbol:drawing scale td be 2:1, or twice as big, type in a 2), and press Return. If you press 
Return without entering a value for the scaling, a value of 1 will be used. At this time, the layer you specified as 
the layer to copy the symbol from will be displayed. To select the symbol you wish to copy, click twice in such a 
manner that the two coordinates you have specified will define a rectangle, or "window", around the desired 
symbol. Please note that arcs are treated as circles in determining if they are in the window; if you have an arc 
with a very large radius, you will have to define your window so that it encompasses the arc's entire radius in all 
directions (i.e. pretend the arc is a circle). Having done this, click once more to indicate a point of reference on 
the symbol. The system will now display the layer you specified as the layer to copy the symbol to; click where 
you would like the symbol to be placed, and it will be drawn with the point of reference placed at the coordinate 
you specify. If you wish to copy more symbols, simply repeat the above steps, otherwise simply press Return 
without specifying a layer number when prompted "Copy symbol from layer number?". 

Before After 

0 .1st click I o·l4thclick 

Q•3rdclick 

2ndclick• 

0 DD 
Note: Symbol Layer Note: Drawing Layer 

Symbol 

This diagram shows the effect of the Symbol command when used to copy a symbol from layer 2 (i.e. the 
circles) to layer 1 (i.e. the rectangles), using a scaling of 1. 
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Parameters : 1) Layer to copy to (integer 1 - 128). 
2) Layer to copy from (Integer 1- 128). 
3) Scaling (real> O and< 1001). 

petault Value: Scaling= 1.00. 

~ 1) The system will continue to prompt you until a valid layer number is entered (i.e. 1- 128). 
2) The system will continue to prompt you until a valid scale is entered (i.e.> O and< 1001). 
3) If the window you specify does not contain a symbol, the system will exit the Symbol command upon 
completion. 
4) When scaling with a ratio greater than 1000, the resulting display may be unpredictable. 

2- 6 



-

Chapter 3 
SCREEN MENU 

The Screen menu contains any commands that pertain to the positioning or scaling of your drawing. Also 
Included in this menu are the grid and layer commands. 

After you have completed this chapter, you will be able to use the Draw Grid, Snap Grid, Use Layer, 
Draw Layer, Erase Layer, Status Layer, Zoom In, zoom Out, zoom Origin, Zoom Screen, 
Zoom Window, Pan, and Redraw commands. 

Draw Grid 

The Draw Grid command is used to display a series of evenly spaced rows and columns of dots. This 
command is useful when the accuracy of a drawing is important. Please note that in some instances the time 
that it takes to display a grid may be lengthy (especially when the grid is very dense). You may find it useful to 
Zoom In first, before displaying the grid, as this will make the grid less dense, and therefore capable of being 
displayed much quicker (see the Zoom In command below). 

Operatjon: Highlight the Draw Grid command in the Screen menu, and release the mouse button. You will 
then be prompted "Grid Size?"; type in the desired grid size and press Return. If you press Return without 
specifying a value for the grid size, a value of 1 unit will be used (discoverCAD uses a generic unit system for 
scaling, where 1 unit can represent any distance). The grid will now be drawn on the screen (when the grid is 
displayed, the command will have a check mark next to it in the Screen menu). To erase a grid, simply 
reselect the Draw Grid command. 

Parameters: Grid Size (real> o and< 1001). 

Default Yatue: Grid Size = 1 unit. Please note that the default value for the grid size will be 1 unit the first time 
the command is used. After that, the default value will be equal to the last value specified. 

Errors.; 1) If the grid size specified is too dense to be drawn, you will be prompted "WARNING: Grid too small. 
Press RETURN to continue.". · 

Snap Grid 

The Snap Grid command is used to "snap" a coordinate to the grid system (your clicks will automatically snap 
to the nearest grid dot). This command is useful when the accuracy of a drawing is important. Please note that 
it is possible to snap to a grid system even if the grid is not currently displayed (the grid size will be equal to the 
last value specified). 

Operation: Highlight the Snap Grid command in the Screen menu, and release the mouse button. The 
snapping feature will now be in effect (when snap is on, the command will have a check mark next to it in the 
Screen menu). To turn the snap off, simply reselect the Snap Grid command. 
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2nd click • 

Snap Grid 

This diagram shows the effect of Snap Grid when using the Draw Line command. 

Parameters: on1ott. 

pefault Value: Snap= Off. 

~ None . 

Use Layer 

The Use Layer command is used to specify which layer to use when drawing. This command is useful when 
you want to divide a drawing into independent levels (ex. a floor plan may have the plumbing on one layer, the 
electrical on another, etc.), providing you with the ability to later view or plot the drawing a layer at a time, or any 
combination thereof. using the Draw Layer and Erase Layer commands (see below). 

Operation: Highlight the Use Layer command in the Screen menu, and release the mouse button . You will 
then be prompted "Layer:"; type in the number of the layer you wish to draw on , and press Return (if you press 
Return without entering a value for the layer, the system will exit the Use Layer command) . From now on, any 
drawing you do will be contained on the specified layer. 

Layer System 

Parameters: Layer (integer 1 - 128). 

Default Value: Layer= 1. 

1st layer 
2nd layer 
3rd layer 

h28 layers 

~ 1) If you don1 specify a valid iayer number (i.e. 1 - 128), the system will ignore what you have entered . 
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Draw Layer 

The Draw ~ayer comm~nd is used to display a previously created layer that is not currently visible. Please 
n~te that th1s command 1s most commonly used to recall, or "draw" a layer that has been temporarily erased 
with the Erase Layer ~ommand (see below). Also, please note that the time it takes to redraw the screen 
may be lengthy, especially when your drawing Is excessively large. 

Operatjon: Highlight the Draw Layer command in the screen menu and release the mouse button. You 
will then be pr~mpted "Layer:"; type in the number of the layer you V.:ish to add to the current display, and 
press Return (if you pres~ Return without entering a value for the layer, the system will exit the Draw Layer 
command). The screen will now be redrawn to include the layer you have specified . 

Before M1.iU 

0 0 
D 

Note: Layer= 2 

Draw Layer 

This diagram shows the effect of the Draw Layer command, assuming you already had one layer displayed 
on screen (i.e. the circle), and that layer 2 contained the rectangle. 

Parameters: Layer (integer 1 - 128). 

Default Value: Layer = 1. 

~ 1) If you don't specify a valid layer number (i.e. 1 - 128), the system will ignore what you have entered. 

Erase Layer 

The Erase Layer command is used to temporarily remove a layer from the current display. Please note that 
this command does not actually erase the layer, but merely hides it from view. Also, please note that the time it 
takes to redraw the screen may be lengthy, especially when your drawing is excessively large. 

Operation; Highlight the Erase Layer command in the Screen menu, and release the mouse button. You 
will then be prompted "Layer:"; type in the number of the layer you wish to remove from the current display, 
and press Return (if you press Return without entering a value for the layer, the system will exit the Erase 
Layer command). The screen will now be redrawn to exclude the layer you have specified. 
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Before After 

0 0 
D 

Note: Layer= 2 

Erase Layer 

This diagram shows the effect of the Erase Layer command, assuming you already had two layers displayed 
on screen, and that layer 2 contained the rectangle. 

Parameters; Layer (integer 1 - 128). 

Default Value; None. 

~ 1) If you don't specify a valid layer number (i.e. 1 - 128), the system will ignore what you have entered. 

Status Layer 

The Status Layer command is used to determine what layer you are currently drawing on, and which layers 
are currently being displayed, or "echoed" on the screen. This command is useful when working with layers as 
described above. 

Operatjon; Highlight the Status Layer command in the Screen menu, and release the mouse button. You 
will then be prompted "Drawing Layer: x. Press RETURN.", where x represents the layer you are currently 
drawing on; note x, then press Return. You will then be prompted "Echoed Layer(s): x y z. Press RETURN.", 
where x, y, and z represent the layer(s) that are currently displayed. You may have to press Return several 
times to list all the echoed layers if there are a lot of layers currently displayed. 

Parameters; None. 

petaurt Value; None. 

f.a:o..cs..; None. 

Zoom In 

The Zoom In command is used to enlarge the current display. This command is useful when you want to do 
detailed work on a small section of the drawing. Please note that the time it takes to redraw the screen when 
zooming may be lengthy, especially when you are enlarging the drawing a significant number of times. 

Operation: Highlight the Zoom In command in the Screen menu, and release the mouse button. You will 
then be prompted "Ratio?"; type in the number of times you want to enlarge the drawing, and press Return 
(ex. if you want to make the drawing three times as big, type in a 3). Please note that if you enter a ratio that has 
a value less than 1, the drawing will actually be reduced. If you press Return without entering a ratio, a value of 
2 will be used. The screen will now be redrawn, enlarged accordingly. 
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Before 

0 
D 

Note: Ratio= 2 

Zoom In 

Parameters: Ratio (real> o and< 1001). 

Default Value: Ratio= 2. 

After 

0 
D 

fn:Qra.;. 1) If a negative number is entered for the ratio, the absolute value of that number will be used in its 
place . 
2) When zooming with a ratio greater than 1000, the resulting display may be unpredictable. 

Zoom Out 

The Zoom Out command is used to reduce the current display. This command is useful when you want to do 
work on a large section of the drawing . Please note that the time it takes to redraw the screen when zooming 
may be lengthy, especially when you are reducing the drawing a significant number of times. 

Operation: Highlight the Zoom Out command in the Screen menu, and release the mouse button. You will 
then be prompted "Ratio?"; type in the number of times you want to reduce the drawing, and press Return 
(ex. if you want to make the drawing three times as small, type in a 3). Please note that if you enter a ratio that 
has a value less than 1, the drawing will actually be enlarged. If you press Return without entering a ratio, a 
value of 2 will be used. The screen will now be redrawn, reduced accordingly. 

Before 

0 
Note: Ratio= 2 D 

Zoom Out 

farameters· Ratio (real> o and< 1001). 

Default Value; Ratio = 2. 

After 

0 
D 

~ 1) If a negative number is entered for the ratio the absolute value of that number will be used in its 
place. · 
2) When zooming with a ratio greater than 1000, the resulting display may be unpredictable. 
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3) If you are using a grid that will be too dense to be drawn after zooming, an error message will be issued. 

zoom Origin 

The zoom Origin command is used to return the display to its original scaling, and place the origin of the grid 
system in the center of the screen (i.e. x = 0, y = 0). This command is useful when, after having adjusted the 
display using the zoom or pan commands, you want to restore the display to its original state (i.e. startup state). 
Please note that the time it takes to redraw the screen when zooming may be lengthy, especially when you are 
enlarging or reducing the drawing a significant number of times. 

Operatjon: Highlight the Zoom Origin command in the Screen menu, and release the mouse button. The 
screen will now be redrawn at the original scale, with the origin of the grid system placed at the center of the 
screen. 

B~,fQre o . After 

0 (X=O,Y=O) D 
• (X=O,Y=O) 

D 
Zoom Origin 

This diagram shows the effect of the Zoom Origin command, assuming the origin had been shifted off 
center, and that the scaling of the drawing had been decreased before the command was issued. 

Parameters: None. 

Default Value; None . 

.E.cm!:s.;. 1) If you are using a grid that will be too dense to be drawn after zooming, an error message will be 
issued. 

Zoom Screen 

The Zoom Screen command is used to adjust the display in such a manner that your entire drawing appears, 
centered on the screen. This command is useful when you want to "frame" your drawing before you print or 
plot. Please note that this command will only take into account the layers currently displayed on screen when 
calculated the frame. Also, please note that the time it takes to redraw the screen when zooming may be 
lengthy, especially when you are enlarging or reducing the drawing a significant number of times. 

Operation; Highlight the Zoom Screen command in the Screen menu, and release the mouse button. You 
will then be prompted "Percentage?"; type in a value that represents the percentage of empty screen that is to 
surround your drawing (think of it as the size of a "frame" that is being placed around your drawing). Please 
note that you will typically want to use a value of 5 or 1 O percent for most drawings. If you press Return without 
entering a value for the percentage, a value of O will be used. The screen will now be redrawn to display your 
entire drawing, with a blank border around it per the percentage specified. 
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B~fore 0 

Note: Percentage = 10 

zoom Screen 

parameters: Percentage (real o - 1000) . 

Default Value; Percentage = o. 

After 

D 0 
D 

frrQ.CS_; 1) If a negative number is entered for the ratio, the absolute value of that number will be used in its 
place. 
2) When zooming with a percentage greater than 1000, the resulting display may be unpredictable. 
3) Please note that arcs are treated as circles in determining if they are in the display; if you have an arc with 
a very large radius, you may notice that the display is shifted . 

Zoom Window 

The Zoom Window command is used to zoom in on a specific portion of your drawing. This command is 
useful when you know exactly which part of your drawing you want to enlarge, and you want to do it quickly 
without having to Zoom In and/or Pan several times . Please note that the time it takes to redraw the screen 
when zooming may be lengthy, especially when you are enlarging the drawing a significant number of times . 

Operation: Highlight the Zoom Window command in the Screen menu, and release the mouse button. 
Now, click twice in such a manner that the two coordinates you have specified will define a rectangle, or 
"window" , around the area you wish to enlarge . The screen will now be redrawn, enlarged accordingly. 

Before 

•1st click 

0 
2nd click• D 

Zoom Window 

farameters; None. 

D.efauu Value.;, None. 

~Z · 1) If the two clicks you use to specify the window lie on the same coordinate, the system will exit the 
com Window command . 
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2) When zooming in on an excessively small area, the resulting display may be unpredictable. 

Pan 

The Pan command is used to shift your drawing to the left, right, top, or bottom. This command is useful whe 
you need more room to draw with, or wish to see a portion of your drawing that isn't currently displayed. Pleas 
note that the time it takes to redraw the screen when panning may be lengthy. 

I 
Operatjon: Highlight the Pan command in the Screen menu, and release the mouse button. Next, click once 

1 
where you would like the pan to start, and once where you would like the pan to end (think of it as placing your 
finger on the screen and sliding the drawing in the desired direction). The screen will now be redrawn, shifted 
accordingly. 

12.~fQ~ 

0 

Pan 

Parameters: None. 

Default Value: None. 

f.crQ.rs.;. None. 

Redraw 

Mw 
2nd click. 0 

D 
•1st click 

D 

The Redraw command is used to redraw the screen display. This command is useful when you wish to 
remove the temporary screen garbage that may accumulate in the process of drawing (ex. the dots left on 
screen by the Trace command or the window left by the Move Copy Window command). Please note that 
the time it takes to redraw the screen when redrawing may be lengthy, especially when your drawing is 
excessively large. 

Operation: Highlight the Redraw command in the Screen menu, and release the mouse button. The screen 
will now be redrawn. 

Parameters: None. 

Default Yatue: None. 

~ None. 
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Chapter 4 
ENTITY MENU 

The Entity menu contains any commands that pertain to the creation of the basic entities of a drawing such 
as lines, circles, arcs , and points (entity is a general term for an individual line, circle, arc, point, etc.). Also 
Included in this menu are the commands necessary to erase such entities . Several of the commands 
discussed In this chapter may be further enhanced by using modifiers and masks as explained in the 
<-Modify Menu and Mask Menu chapters . Please note that once you have initiated one of the Entity 
commands , you will remain in that command until another command is selected. Also, please note that it is 
worthwhile to review the Draw Tutorial appendix to take full advantage of these commands . 

After you have complet ed this chapter , you will be able to use the Draw Line, Erase Line, Draw 
Rectangle, Draw Clrcle, Erase Circle, Draw Arc, Erase Arc, Draw Point, Erase Point, Erase, 
Erase Window, and Erase All commands. 

Draw Line 

The Draw Line command is used to draw a straight line between two coordinates. Please note that it is 
worthwhile to review the following chapter <-Modify Menu to take full advantage of this command. 

Operation : Highlight the Draw Line command in the Entity menu, and release the mouse button. Next, click 
once where you would like the line to begin, and once where you would like it to end . The line will now be 
drawn between the two coordinates specified. 

Before 

• 2nd click 

Draw Line 

Parameters : None. 

Default Vatue : None . 

1st click • 

~ 1) If the two clicks you used to specify the line lie on the same coordinate, the system will not draw the 
line. 
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Erase Line 

The Erase Line command is used to permanently erase a line from your drawing. 

Qperatjon; Highlight the Erase Line command in the Entity menu, and release the mouse button. Click on 
the line you wish to erase, and it will be permanently removed from your drawing. 

Parameters· None. 

Default Value; None. 

~None. 

Draw Rectangle 

The Draw Rectangle command is used to draw rectangles of any shape or size. Please note that in order to 
erase a rectangle, you must use either the Erase Line, Erase, or Erase Window commands. 

Operation; Highlight the Draw Rectangle command in the Entity menu, and release the mouse button. 
Next, click twice in such a manner that the coordinates you have specified will define the rectangle you desire. 
The rectangle will now be drawn accordingly. 

Before 

• 1st click 

2nd click• 

Draw Rectangle 

Parameters; None. 

Default Value; None. 

. 

~ 1) If the two clicks you used to specify the rectangle lie on the same coordinate, or in a straight line, the 
system will not draw the rectangle. 

Draw Circle 

The Draw Circle command is used to draw circles. Please note that it is worthwhile to review the following 
chapter <-Modify Menu to take full advantage of this command. 

Operatjon; Highlight the Draw Circle command in the Entity menu, and release the mouse button. Next, 
click three times in such a manner as to define the circumference of the circle. The circle will now be drawn, 
passing through the three coordinates you have specified. 
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Before 

1st click• 

•2nd click 

3rd click• 

Draw Clrcle 

Parameters; None. 

Default Value; None. 

~ 1) If the three clicks you used to specify the circle lie on the same coordinate, or in a straight line, the 
system will not draw the circle. . 

Erase Circle 

The Erase Clrcle command is used to pennanently erase a circle from your drawing. 

Operatjon; Highlight the Erase Circle command in the Entity menu, and release the mouse button. Click 
on the circle you wish to erase, and it will be permanently removed from your drawing. 

Parameters: None. 

Default Value: None. 

fr.co.cs..; None. 

Draw Arc 

The Draw Arc command is used to draw arcs. Please note that arcs are drawn in a counterclockwise manner, 
and that you should define your coordinates accordingly. Also, please note that it is worthwhile to review the 
following chapter <-Modify Menu to take full advantage of this command. 

Operation: Highlight the Draw Arc command in the Entity menu, and release the mouse button. Next, click 
three times in such a manner as to define the circumference of the arc. Remember that arcs are drawn 
counterclockwise, so you will typically want your first click to represent the starting angle of the arc, and the 
third click the ending angle of the arc. The arc will now be drawn, counterclockwise, passing through the three 
coordinates you have specified. 
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Before 

•1st click 

•2nd click 

3rd click• 

Draw Arc 

Parameters: None. 

Default Value: None. 

~ 1) If the three clicks you used to specify the arc lie on the same coordinate, or in a straight line, the 
system will not draw the arc. 

Erase Arc 

The Erase Arc command is used to permanently erase an arc from your drawing. Please note that if you are 
having difficulty erasing an arc, it may be useful to try clicking on either end of the arc. 

Operation: Highlight the Erase Arc command in the Entity menu, and release the mouse button. Click on 
the arc you wish to erase, and it will be permanently removed from your drawing. 

Before 

'(_ 

Erase Arc 

Parameters: None. 

Default Value: None. 

~ None. 

Draw Point 

0 0 

The Draw Point command is used to draw points (a point appears as a small cross, or addition sign"+"). This 
command is particularly useful when you are constructing center lines. Please note that it is worthwhile to 
review the following chapter <·Modify Menu to take full advantage of this command. 
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Operatjon: Highlight the Draw Point command in the Entity menu, and release the mouse button. Click 
once where you would like the point to appear, and it will be drawn. 

Before 

. • Click 

Draw Point 

Parameters: None. 

Default Value: None. 

f.rrQra.; None. 

Erase Point 

Mm[ 

+ 

The Erase Point command is used to permanently erase a point from your drawing. 

Operation: Highlight the Erase Point command in the Entity menu, and release the mouse button. Click on 
the point you wish to erase, and it will be permanently removed from your drawing. 

Parameters: None. 

Default Value: None. 

Errors: None. 

Erase 

The Erase command is used to permanently erase any of the above entities. Please note that if your drawing 
is extremely complicated, you may wish to use one of the more specific erase commands as described above, 
as this command may erase the. wrong entity by mistake (ex. if you wish to erase a point that is in the midst of 
several other entities, it may be wise to use the Erase Point command instead of the Erase command). 

Operatjon: Highlight the Erase command in the Entity menu, and release the mouse button. Click on the 
line, circle, arc, or point you wish to erase, and it will be permanently removed from your drawing. 

parameters: None. 

Default Value; None. 

Errors: None. 
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Erase Window 

The Erase Window command is used to permanently erase several entities at a time. This command is 
useful when you wish to erase an entire area of your drawing, or a symbol you no longer need. After you have 
specified the erase window, any entity contained within the window, and not touching the edge of the 
window, will be erased. Please note that a temporary window will be left on the screen after you have used this 
command; simply execute the Redraw command to redraw the screen if so desired (see the Screen Menu 
chapter). Also, please note that arcs are treated as circles in determining if they are in the window; if you have 
an arc with a very large radius, you will have to define your window so that it encompasses the arc's entire 
radius in all directions (i.e. pretend the arc is a circle). Finally, please note that this command will not erase text 
or dimensioning. 

Qperatjon; Highlight the Erase Window command in the Entity menu, and release the mouse button. 
Next, click twice in such a manner that the coordinates you have specified will define a rectangle, or "window", 
around the area you wish to erase. Any entities contained within the window you have specified will now be 
permanently removed from your drawing. 

Before After •1:~ 0 r--------::i~ 

O'Q. 
Erase Window 

Parameters: None. 

Default Value; None . 

.Ermrs;. None. 

Erase All 

The Erase All command is used to erase your entire drawing from the display. Please note that if you wish to 
later retrieve the drawing from disk, you must Save it (see the FIie Menu chapter) before you Erase All. 

Operation: Highlight the Erase All command in the Entity menu, and release the mouse button. You will 
then be prompted "WARNING: Wish to erase this drawing? (Y/N)"; type in Y, and the entire drawing will be 
erased from the display. If you type in N, the system will exit the Erase All command. 

Parameters: None. 

Default Value: None. 

~ 1) The system will not accept your response unless you have the Caps Lock key depressed. 
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Chapter 5 
"'MODIFY MENU 

The <-Modify menu contains any modifiers that pertain to the Draw Line, Draw Rectangle, Draw 
circle Draw Arc, and Draw Point commands as described in the Entity Menu chapter. Modifiers are 
differe~t from commands in that it is necessary to activate a command before you can use a modifier (think of a 
modifier as an adjective that enhances the command it is used with). For example, if you desired to draw lines 
that were always vertical, you would first select the Draw Line command from the Entity menu, then select 
the vertical modifier from the first <-Modify menu, and proceed with the command as usual (please note 
that there are two <-Modify menus, one for the Entity menu and one for the Text & Dimension menu). 
Please note that it is important to remember that modifiers are deactivated once you exit the command they 
are modifying (except for the Hidden and Length modifiers). 

After you have completed this chapter, you will be able to use the None, Hidden, Length, Vertical, 
Horizontal, Parallel, Perpendicular, Angle, Radius, Diameter, and Intersect modifiers. 

None 

The None modifier is used to deactivate any modifier that may be currently in effect (ex. you had been using 
Draw Line with the Vertical modifier, but now desire to use Draw Line without any modifiers). Please note 
that the None modifier will not affect the Hidden or Length modifiers. 

Operatjon; Highlight the None modifier in the <-Modify menu, and release the mouse button. Any modifier 
that was in effect will now be canceled. 

Parameters; None. 

Default Value; None. 

~None. 

Hidden 

The Hidden modifier is used to draw dashed, or "hidden" lines when using the Draw Line, Draw 
Rectangle, Draw Circle, and Draw Arc commands. Please note that this command may be used in 
conjunction with any of the other modifiers listed in this chapter. 

Operatjon· Highlight the Hidden modifier in the <·Modify menu, and release the mouse button. From now 
on, whenever you draw any lines, rectangles, circles, or arcs, they will be dashed (when hidden is o·n, the 
modifier will have a check mark next to it in the <·Modify menu). To turn hidden off, simply reselect the 
Hidden modifier. 

farameters: On/Off. 

Default Ya1ue; Hidden= Off. 

~ None. 
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Length 

The Length modifier is used to modify the Draw Line command, and will allow you to specify the exact 
length of a line. Please note that this command may be used in conjunction with any of the other line modifiers 
(i.e. Vertical, Horlzontal, Parallel, Perpendlcular, Angle) listed in this chapter. 

Operatjon; After you have selected the Draw Line command from the Entity menu, highlight the Length 
modifier in the <·Modify menu, and release the mouse button. Next, click once where you would like the line 
to start. You will then be prompted "Length:"; type in the desired length of the line, and press Return (if you 
press Return without entering a value for the length, the system will not draw the line). Remember that 
discoverCAD uses a generic unit system for scaling, where 1 unit can represent any distance. Finally, click in 
the direction that you would like the line to be drawn (depending on the length you have specified for the 
length, the line may or may not pass through the coordinate used to define the direction). When length is on, 
the modifier will have a check mark next to it in the <·Modify menu. To turn length off, simply reselect the 
Length modifier. 

fJ.efQr~ 
. 

1st click 
• . •· 

2nd click . . 

Note: (englh = 3.5 

Draw Line Length 

parameters; Length (real > o and < 1001 ). 

Qefautt Value; None. 

Ml.i.! 

. . . 
. . . 

. 

~ 1) If a negative number is entered for the length, the absolute value of that number will be used in its 
place. 
2) When drawing with a length greater that 1001, the resulting line may be unreliable. 

Vertical 

The Vertical modifier is used to modify the Draw Line command , and will allow you to draw a line that is 
perfectly vertical. A vertical line is defined as a line that starts at point A, and extends to point B, where B is 
straight up or straight down from point A. Please note that this modifier may be used in conjunction with the 
Hidden and Length modifiers, but will cancel any other modifiers currently in effect. 

Operatjon; After you have selected the Draw Line command from the Entity menu, highlight the Vertical 
modifier in the <·Modify menu, and release the mouse button. Next, click once where you would like the 
vertical line to start, and once where you would like it to end (the second coordinate is defining the length of 
the line, since it will be drawn vertical no matter what). The vertical line will now be drawn. 
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Before 

• 2nd click 

• 1st click 

Draw Line Vertical 

eacameters: None. 

~fault varue: None . 

After 

fIIQLS.;. 1) If the second coordinate you click lies on the same horizontal plane as the first coordinate you click, 
the system will not draw the line. 

Horizontal 

The Horizontal modifier is used to modify the Draw Line command, and will allow you to draw a line that is 
perfectly horizontal. A horizontal line is defined as a line that starts at point A , and extends to point B, where B 
is straight right or straight left from point A. Please note that this modifier may be used in conjunction with the 
Hidden and Length modifiers, but will cancel any othe r modifiers currently in effect. 

Operation: After you have selected the Draw Line command from the Entity menu, highlight the 
Horizontal modifier in the <·Modify menu, and release the mouse button. Next, click once where you 
would like the horizontal line to start , and once where you would like it to end (the second coordinate is 
defining the length of the line, since it will be drawn horizontal no matter what). The horizontal line will now be 
drawn. 

Before 

.2nd click 

• 1st click 

Draw Line Horizontal 

farameter~ None. 

Detaun Yalu~ None. 

After 

~~ 1). If the second coordinate you click lies on the same vertical plane as the first coordinate you click, the 
1 em will not draw the line. 
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Parallel 

The Parallel modifier is used to modify the Draw Line command, and will allow you to draw a line that is 
perfectly parallel to an existing line. A parallel line is defined as a line whose distance to an existing line remains 
constant at every point. This modifier is useful when constructing isometric drawings. Please note that this 
modifier may be used in conjunction with the Hidden and Length modifiers, but will cancel any other 
modifiers currently in effect. 

Qperatjon; After you have selected the Draw Line command from the Entity menu, highlight the Parallel 
modifier in the <·Modify menu, and release the mouse button. First, click on t.he existing line that you wish to 
use as a reference for the new parallel line. Next, click once where you would like the parallel line to start, and 
once where you would like it to end. The new line will be drawn, perfectly parallel to the line you specified with 
the first click. 

Before 

3rd click. 

•2nd click 

Draw Line Parallel 

Parameters: None. 

Default Value: None. 

frrQrs.;, None. 

Perpendicular 

The Perpendicular modifier is used to modify the Draw Line command, and will allow you to draw a line 
that is perfectly perpendicular to an existing line. A perpendicular line is defined as a line whose angle in 
relationship to an existing line is 90 degrees (i.e. right angle). This modifier is useful when constructing 
isometric drawings. Please note that this modifier may be used in conjunction with the Hidden and Length 
modifiers, but will cancel any other modifiers currently in effect. 

Operation; After you have selected the Draw Line command from the Entity menu, highlight the 
Perpendicular modifier in the <·Modify menu, and release the mouse button. First, click on the existing 
line that you wish to use as a reference for the new perpendicular line. Next, click once where you would like 
the perpendicular line to start, and once where you would like it to end. The new line will be drawn, perfectly 
perpendicular to the line you specified with the first click. 
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Before 

• 2nd click 

3rd click. 

Draw Line Perpendicular 

Parameters: None . 

Default Value: None . 

~ None . 

Angle 

The Angle modifier is used to modify the Draw Line command, and will allow you to draw a line of a specified 
angle in relationship to an existing line. This modifier is useful when constructing isometric drawings. Please 
note that this modifier may be used in conjunction with the Hidden and Length modifiers, but will cancel 
any other modifiers currently in effect. 

Operation: After you have selected the Draw Line command from the Entity menu, highlight the Angle 
modifier in the <-Modify menu, and release the mouse button. First, click on the existing line that you wish to 
use as a reference for the new angular line (typically you will want to click on a horizontal line to use as a 
reference). You will then be prompted "Angle:"; type in the desired angle of the line in relationship to the 
existing line, and press Return (if you press Return without entering a value for the angle, the system will not 
draw the line) Next, click once where you would like the angular line to start, and once wh~re you would like it 
to end. The new line will be drawn with the specified angle in relationship to the line you specified with the first 
click. 

Before 
3rd click• 

•2nd click 

1st click 

Note: Angle = 45 

Draw Line Angle 

Parameters: Angle (real o -359). 

Pefaurt Value: None. 

Errors: 1) If a negative number is entered for the angle, the absolute value of that number will be used instead. 
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Radius 

The Radius modifier is used to modify the Draw Circle and Draw Arc commands, and will allow you to 
specify the exact radius of a circle or arc. The radius of a circle or arc is defined as the distance between the 
center, or "origin" of the circle/arc to any point on the circumference of the circle/arc. Please note that you may 
define the radius by typing in a value or by using the mouse. Please note that this modifier may be used in 
conjunction with the Hidden modifier, but will cancel any other modifiers currently in effect. 

Operatjon; After you have selected the Draw Circle or Draw Arc command from the Entity menu, highlight 
the Radius modifier in the <-Modify menu, and release the mouse button. Next, click where you would like 
the center, or "origin", of the circle or arc to be. You will the be prompted "Radius?". 

If you want to use a numerical value to define the radius, follow this set of instructions: Type in the desired 
radius of the circle or arc, and press Return. If you are using the Radius modifier with the Draw Circle 
command, the circle will now be drawn according to the specified radius. If you are using the Radius modifier 
with the Draw Arc command, click once to define the starting angle of the arc, and once to define the ending 
angle of the arc. The arc will now be drawn according to the specified radius, starting angle, and ending angle, 
in a counterclockwise direction. 

If you want to use the mouse to define the radius, follow this set of instructions: Press Return without entering 
a value for the radius. If you are using the Radius modifier with the Draw Circle command, click once to 
define the radius of the circle (i.e. the distance between your first click for the origin and the second click will 
be the radius), and the circle will now be drawn according to the specified radi1,1s. If you are using the Radius 
modifier with the Draw Arc command, click once to define the radius and starting angle of the arc, and once 
to define the ending angle of the arc. The arc will now be drawn according to the specified radius, starting 
angle, and ending angle, in a counterclockwise direction. 

Before 

1st click• 

2nd click. 

Note: Radius= Return 

Draw Circle Radius 

Parameters: Radius (real> o and< 1001). 

Default Value; None . 

.frro..rs.;, 1) If a negative number is entered for the radius, the absolute value of that number will be used in its 
place. 
2) When drawing with a radius greater that 1001, the resulting circle or arc may be unreliable. 
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Diameter 

The Diameter modifier is used to modify the Draw Circle and Draw Arc commands, and will allow you to 
specify the exact diameter of a circle or arc. The diameter of a circle or arc is defined as the distance of a straight 
line passing through the center of the circle/arc, ending at the outermost points of the circle/arc. Please note 
that you may define the diameter by typing in a value or by using the mouse. Also, please note that this 
modifier may be used in conjunction with the Hidden modifier, but will cancel any other modifiers currently in 
effect. 

Operat;on: After you have selected the Draw circle or Draw Arc command from the Entity menu, highlight 
the Diameter modifier in the <·Modify menu, and release the mouse button. Next, click where you would 
like the center, or "origin", of the circle or arc to be. You will the be prompted "Diameter?". 

If you want to use a numerical value to define the diameter, follow this set of instructions: Type in the desired 
diameter of the circle or arc, and press Return. If you are using the Diameter modifier with the Draw Circle 
command, the circle will now be drawn according to the specified diameter. If you are using the Diameter 
modifier with the Draw Arc command, click once to define the starting angle of the arc, and once to define 
the ending angle of the arc. The arc will now be drawn according to the specified diameter, starting angle, and 
ending angle. 

If you want to use the mouse to define the diameter, follow this set of instructions: Press Return without 
entering a value for the diameter. Next, click once to define the diameter of the circle or arc (i.e. the distance 
between your first click for the origin and the second click will be the diameter. The point originally specified as 
the origin will now be considered a point on the circumference of the circle or arc). If you are using the 
Diameter modifier with the Draw Circle command, the circle will now be drawn according to the specified 
diameter. If you are using the Diameter modifier with the Draw Arc command, the arc will now be drawn 
counterclockwise according to the specified diameter. 

Before 

2nd click 
• 

1st click 

Note: Diameter= Return 

Draw Arc Diameter 

Parameters: Diameter (real> O and< 1001). 

Default Value: None. 

• 

~ 1) If a negative number is entered for the diameter, the absolute value of that number will be used in its 
place. 
2) When drawing with a diameter greater that 1001, the resulting circle or arc may be unreliable. 
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Intersect 

The Intersect modifier is used to modify the Draw Point command, and will allow you to draw a point at the 
intersection of two existing lines. 

Operation: After you have selected the Draw Point command from the Entity menu, highlight the 
Intersect modifier in the <·Modify menu, and release the mouse button. Next, click once on the first line, 
and once on the second line. The point will now be drawn at the intersection of the two lines. 

Parameters: None. 

Default Value: None. 

~ 1) If the two lines specified are parallel, the system will not draw the point. 
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Chapter 6 
TEXT & DIMENSION MENU 

The Text & Dimension menu contains any commands that pertain to the creation of text and dimensioning. 
Text may be any notes or messages you might add to your drawing such as a name, date, description, etc. 
Dimensioning is a process that calculates the length of a line, the radius of a circle or arc, or the diameter of a 
circle or arc, and automatically draws the correct dimension lines, extension lines, arrowheads, and dimension 
text. Also included in this menu are the commands necessary to erase such entities. Several of the commands 
discussed in this chapter may be further enhanced by using modifiers and masks as explained in the 
c-Modlfy Menu and Mask Menu chapters. 

After you have completed this chapter, you will be able to use the Draw Linear Dim, Erase Linear Dim, 
Draw Radial Dim, Erase Radial Dim, Draw Diameter Dim, Erase Diameter Dim, Draw Text , 
Erase Text, and Erase All commands. 

Draw Linear Dim 

The Draw Linear Dim command is used to indicate the distance between two locations. These locations 
can be the ends of lines, circles, arcs, or points. Please note that if you are using the Draw Linear Dim 
command without the Vertical modifier, you will only be able to dimension lines that have an angle less than 
90 degrees (please note that it is worthwhile to review the following chapter <·Modify Menu to take full 
advantage of this command). 

Operatjon: Highlight the Draw Linear Dim command in the Text & Dimension menu, and release the 
mouse button. Next, click once near the end of the first entity, and once near the end of the second entity 
(you may click near the other end of the first entity if you wish to dimension just that one entity). Finally, click 
where you would like the dimension text to appear. The dimension lines, extension lines, arrowheads, and 
dimension text will now be drawn. 

'2.tlfQftl 
2nd click 

~ 
1st click 

•3rd click 

Draw Linear Dim 

Parameters: None. 

petauft Value: Horizontal. 

After 

c.J 
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Erase Linear Dim 

The Erase Linear Dim command is used to permanently erase a linear dimension from your drawing. 

Operatjon-Highlight the Erase Linear Dim command in the Text & Dimension menu, and release the 
mouse button. Click near the lower left comer of the dimension text of the linear dimension you wish to erase, 
and the entire linear dimension will be permanently removed from your drawing. 

aetQre M1M 

c.J ------------
Erase 

Parameters: None. 

Default Yafue: None . 

f.a:Q.rs.;, None . 

Draw Radial Dim 

click 

Linear Dim 

The Draw Radlal Dim command is used to dimension the radius of circles and arcs. Please note that the 
dimension text will be followed by a R to indicate radius. Also, please note that if you are having difficulty 
dimensioning an arc, it may be useful to try clicking on either end of the arc. Finally, please note that it is 
worthwhile to review the following chapter <·Modify Menu to take full advantage of this command. 

Operation; Highlight the Draw Radial Dim command in the Text & Dimension menu, and release the 
mouse button. Next, click on the circle or arc you want to dimension. Finally, click where you would like the 
dimension text to appear (if you click inside the circle or arc, the system will not draw the dimension). The 
dimension line, leader line, arrowhead, and dimension text will now be drawn. 

BefQre 
3.15 R 

1st click 

Draw Radlal Dim 
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earameters: None . 

.Qefault ya1ue: None. 

~ 1) If you click inside the circle or arc, the system will not draw the dimension. 

Erase Radial Dim 

The Erase Radial Dim command is used to permanently erase a radial dimension from your drawing. 

Qperatjon: Highlight the Erase Radial Dim command in the Text & Dimension menu, and release the 
mouse button. Click near the lower left corner of the dimension text of the radial dimension you wish to erase, 
and the entire radial dimension will be permanently removed from your drawing. 

Before 
~.15 R 
click 

Erase Radial Dim 

Parameters: None. 

Default varue: None. 

f.crQrs: None. 

Draw Diameter Dim 

The Draw Diameter Dim command is used to dimension the diameter of circles and arcs. Please note that 
the dimension text will be followed by a DIA to indicate diameter. Also, please note that if you are having 
difficulty dimensioning an arc, it may be useful to try clicking on either end of the arc. Finally, please note that it 
is worthwhile to review the following chapter <-Modify Menu to take full advantage of this command. 

Operatjon-Highlight the Draw Diameter Dim command in the Text & Dimension menu, and release the 
mouse button. Next, click on the circle or arc you want to dimension. Finally, click where you would like the 
dimension text to appear (if you click inside the circle or arc, the system will not draw the dimension). The 
dimension line, leader line, arrowheads, and dimension text will now be drawn. 

6 - 3 



,I 
Before 

• 
2nd click 

Draw Diameter Dim 

parameters: None. 

Default Value: None. 

EaQrs.;, 1) If you click inside the circle or arc, the system will not draw the dimension. 

Erase Diameter Dim 

The Erase Diameter Dim command is used to permanently erase a diameter dimension from your drawing. 

Operatjon: Highlight the Erase Diameter Dim command in the Text & Dimension menu, and release the 
mouse button. Click near the lower left corner of the dimension text of the diameter dimension you wish to 
erase, and the entire diameter dimension will be permanently removed from your drawing. 

parameters: None. 

Default Value; None . 

.E.ccom.; None. 

Draw Text 

The Draw Text command is used to draw text. Please note that it is worthwhile to review the following 
chapter <-Modify Menu to take full advantage of this command. 

Operatjon; Highlight the Draw Text command in the Text & Dimension menu, and release the mouse 
button. Next, click once where you would like the text to start. You will then be prompted "Text:"; type in the 
desired text (if you make a mistake while typing the text, you may use the Delete or Left Arrow keys to remove 
the error). Now press Control a (depress the Control and a key at the same time). If you press Control a 
without typing any text, the system will not draw the text. The text will now be drawn. 
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Before After 

.click THIS IS TEXT 

Note: Text= THIS IS TEXT 

Draw Text 

earameters: Text (Up to 80 alphanumeric characters). 

Q.efautt ya1ue: 1) Height= 0.15 units. 
2) Width = 0.12 units. 
3) Slant = O degrees. 
4) Angle = O degrees. 
5) Justification = Left. 

.EaQ.rs..; 1) If you try to type the text and nothing appears, make sure the Caps Lock key is depressed. 
2) If you type more than 80 characters for the text, the text will be truncated to 80 characters. 

Erase Text 

. The Erase Text command is used to permanently erase text from your drawing. 

Operatjon: Highlight the Erase Text command in the Text & Dimension menu, and release the mouse 
button. Click near the lower left corner of the text you wish to erase, and the entire text string will be 
permanently removed from your drawing. Please note that if the text you are trying to erase has been created 
using either the Center Justify or Right Justify modifier, you will have to adjust your click accordingly. For 
text that is center justif jed, click near the lower middle of the text. For text that is right justified , click near the 
lower right corner of the text. 

Before 

.THIS IS TEXT 
click 

Erase 

faramete~ None . 

Oetaun Value.; None . 

~None . 

Text 

After 
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Erase All 

The Erase All command is used to erase your entire drawing from the display. Please note that if you wish to 
later retrieve the drawing from disk, you must Save it (see the FIie Menu chapter) before you Erase All. 

Qperatjon: Highlight the Erase All command in the Text & Dimension menu, and release the mouse 
button. You will then be prompted "WARNING : Wish to erase this drawing? (Y/N)": type in Y, and the entire 
drawing will be erased from the display. If you type in N, the system will exit the Erase All command. 

parameters: None. 

petault va1ue: None. 

~ 1) The system will not accept your response unless you have the Caps Lock key depressed. 
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Chapter 7 
<-MODIFY MENU 

The <-Modify menu contains any modifiers that pertain to the Draw Linear Dim, Draw Radial Dim, 
oraw Diameter Dim, and Draw Text commands as described in the Text & Dimension Menu chapter. 
Modifiers are different from commands in that it is necessary to activate a command before you can use a 
modifier (think of a modifier as an adjective that enhances the command it is used with). For example, if you 
desired to dimension a line that was vertical, you would first select the Draw Linear Dim command from the 
Text & Dimension menu, then select the Vertical modifier from the second <·Modify menu, and 
proceed with the command as usual (please note that there are two <-Modify menus, one for the Entity 
menu and one for the Text & Dimension menu). Please note that it is important to remember that modifiers 
are deactivated once you exit the command they are modifying. 

After you have completed this chapter, you will be able to use the None, Precision, Alternate Text, 
Vertical, Horizontal, Point to Point, Height, Width, Slant, Angle, Left Justify , Center Justify, 
and Right Justify modifiers. 

None 

The None modifier is used to deactivate any modifier that may be currently in effect (ex. you had been using 
Draw Linear Dim with the Vertical modifier, but now desire to use Draw Linear Dim without any 
modifiers). 

Qpera1jon: Highlight the None modifier in the <-Modify menu, and release the mouse button. Any modifier 
that was in effect will now be canceled. 

Parameters: None. 

Default Value: None. 

~ None. 

Precision 

The Precision modifier is used to modify the Draw Linear Dim, Draw Radial Dim, and Draw Diameter 
Dim commands, and will allow you to specify the number of digits following the decimal point for the 
dimension text. Please note that the dimension text for any of the dimensioning commands will have two digits 
after the decimal point if you do not use this modifier. 

Operation: After you have selected the Draw Linear Dim, Draw Radial Olm, or Draw Diameter Dim 
from the Text & Dimension menu, highlight the Precision modifier in the <·Modify menu, and release 
the mouse button. You will then be prompted "Precision:"; type in the desired precision of the dimensioning, 
and press Return (if you make a mistake while typing the precision, you may use the Delete or Left Arrow keys 
to remove the error). Having entered the precision, you may now proceed with the command as you normally 
would (each dimension drawn from now on will appear with the specified precision, until you select another 
command). Please note that the precision will revert to its default value once you exit the Draw Linear Dim, 
Draw Radial Dim, or Draw Diameter Dim command (i.e. the next time you Draw Linear Dim, Draw 
Radial Dim, or Draw Diameter Olm without a modifier, the precision will be 2). 
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Before 

~ck 

1st click 

• 
3rd click 

Note : Precision = 3 

Draw Linear Dim Precision 

Parameters; Precision (integer o -4). 

pefautt Yatue; Precision= 2. 

~ 1) If you press Return without entering a value for the precision, or enter an invalid value, the system 
will use the precision last specified. 

Alternate Text 

The Alternate Text modifier is used to modify the Draw Linear Dim, Draw Radial Dim, and Draw 
Diameter Dim commands, and will allow you to substitute the dimension text with text of your own. 

Operation; After you have selected the Draw Linear Dim, Draw Radial Dim, or Draw Diameter Dim 
from the Text & Dimension menu, highlight the Alternate Text modifier in the <-Modify menu, and 
release the mouse button. You will then be prompted "Text:"; type in the desired text (if you make a mistake 
while typing the text, you may use the Delete or Left Arrow keys to remove the error) . Now press Control Q 
(depress the Control and Okey at the same time). Having entered the text, you may now proceed with the 
command as you normally would (each dimension drawn from now on will appear with the specified text, until 
you select another command). 

Before 

~ck cJ 1st click 

• 
3rd click 

Note: Alternate Text= TEXT 

Draw Linear Dim Alternate Text 

Parameters; None. 

Petautt Value; None. 

~ 1) If you press Return without entering any text, the system will use the text last specified. 
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Vertical 

The Vertical modifier is used to modify the Draw Linear Dim command, and will allow you to dimension 
vertically. Please note that once you exit the Draw Linear Dim command, this modifier will no longer be in 
effect (i.e. the next time you use Draw Linear Dim without a modifier, it will assume you want to dimension 
horizontally). 

Qperatjon: After you have selected the Draw Linear Dim command from the Text & Dimension menu, 
highlight the Vertical modifier in the <-Modify menu, and release the mouse button. Proceed with the 
command as you normally would. 

Before ~ 
• 2nd click 

T 
• 3.15 

3rd click 

_J 
• 1st click 

Draw Linear Dim Vertical 

Parameters: None. 

Default Value: None. 

~ 1) If you try to dimension horizontally, the system will not draw the dimension. 

Horizontal 

The Horizontal modifier is used to modify the Draw Linear Dim command, and will allow you to dimension 
a line that is horizontal. Please note that the only time you will have to use this modifier is when you want to 
switch from the Vertical modifier to the Horizontal modifier (i.e. Draw Linear Dim always assumes 
horizontal dimensioning unless you tell it otherwise). 

Operation: After you have selected the Draw Linear Dim command from the Text & Dimension menu, 
highlight the Horizontal modifier in the <-Modify menu, and release the mouse button. Proceed with the 
command as you normally would. 

Parameters: None. 

Default Yafue: None. 

~ 1) If you try to dimension vertically, the system will not draw the dimension. 
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Point to Point 

The Point to Point modifier is used to modify the Draw Linear Dim command, and will allow you to create 
point-to-point dimensions. This command is useful when you want the dimension line to be parallel to the line 
you are dimensioning. Please note that the dimension text will indicate the true distance between the two 
locations. Also, please note that once you exit the Draw Linear Dim command, this modifier will no longer 
be in effect (i.e. the next time you use Draw Linear Dim, it will assume you want to dimension horizontally). 

Operatjon; After you have selected the Draw Linear Dim command from the Text & Dimension menu, 
highlight the Point to Point modifier in the c-Modlfy menu, and release the mouse button. Proceed with 
the command as you normally would. 

Before 2nd click 

•3rd click 

Draw Linear Dim Point to Point 

Parameters: None . 

Default Value; None. 

~ None. 

Height 

The Height modifier is used to modify the Draw Text command, and will allow you to specify the height of 
the text you are drawing. Please note that text drawn with a height less than or equal to 0.15 units may be 
somewhat illegible due to the resolution of the computer screen. However, when plotted, the text will appear 
razor sharp . 

Operation: After you have selected the Draw Text command from the Text & Dimension menu, highlight 
the Height modif ier In the <·Modify menu , and release the mouse button . You will then be prompted 
"Height:" ; type in the desired height of the text , and press Return (if you make a mistake while typing the 
height, you may use the Delete or Left Arrow keys to remove the error) . Having entered the height, you may 
now proceed with the command as you normally would (all text drawn from now on will appear with the 
specified height, until you select another command). Please note that the height will revert to its default value 
once you exit the Draw Text command (i.e. the next time you Draw Text without a modifier, the height will 
be 0.15 units). 
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Before 

•Click 

Note: Height= 1 unit 

Draw Text Height 

parameters; Height (real> o and< 1001). 

Default Value; Height= 0.15 units. 

After 

rn ~ ~rm 

Errors; 1) If you press Return without entering a value for the height, the system will use the height last 
specified . 
2) If a negative number is entered for the height, the absolute value of that number will be used in its place. 
3) When drawing with a height greater than 1000, the resulting display may be unreliable . 

Width 

The Width modifier is used to modify the Draw Text command, and will allow you to specify the width of the 
text you are drawing: Please note that text drawn with a width less than or equal to 0.12 units may be 
somewhat illegible due to the resolution of the computer screen. However, when plotted, the text will appear 
razor sharp. 

Operation : After you have selected the Draw Text command from the Text & Dimension menu, highlight 
the Width modifier in the <-Modify menu, and release the mouse button. You will then be prompted 
"Width:"; type in the desired width of the text, and press Return (if you make a mistake while typing the width, 
you may use the Delete or Left Arrow keys to remove the error). Having entered the width, you may now 
proceed with the command as you normally would (all text drawn from now on will appear with the specified 
width, until you select another command). Please note that the width will revert to its default value once you 
exit the Draw Text command (i.e. the next time you Draw Text without a modifier, the width will be 0.12 
units). 

Before Mm 

• click THIS IS T 

Note: Width= 0.5 unit 

Draw Text Width 
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parameters· Width (real> o and< 1001). 

Default Value; Width= 0.12 units. 

f.cmrs.:. 1) If you press Return without entering a value for the width, the system will use the width last specified. 
2) If a negative number is entered for the width, the absolute value of that number will be used in its place. 
3) When drawing with a width greater than 1000, the resulting display may be unreliable. 

Slant 

The Slant modifier is used to modify the Draw Text command, and will allow you to specify the slant of the 
text you are drawing. Please note that this modifier is useful when you wish to simulate italicized text. 

Operatjon; After you have selected the Draw Text command from the Text & Dimension menu, highlight 
the Slant modifier in the <-Modify menu, and release the mouse button. You will then be prompted "Slant:"; 
type in the desired slant of the text, and press Return (if you make a mistake while typing the slant, you may 
use the Delete or Left Arrow keys to remove the error). Having entered the slant, you may now proceed with 
the command as you normally would (all text drawn from now on will appear with the specified slant, until you 
select another command). Please note that the slant will revert to its default value once you exit the Draw 
Text command (i.e. the next time you Draw Text without a modifier, the slant will be o degrees). 

Before 

•Click 

Note: Slant= 45 degrees 

Draw Text Slant 

Parameters; Slant (real -45 through 45 degrees). 

Default yarue; Slant = O degrees. 

~ 

THIS JS TEXT 

f.cmrs.:. 1) If you press Return without entering a value for the slant, or enter an invalid value, the system will use 
the slant last specified. 
2) If you attempt to draw text with a slant greater than 45 degrees or less than -45 degrees, the text may appear 
illegible. 
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Arigle 

The Angle modifier is used to modify the Draw Text command, and will allow you to specify the angle of the 
text you are drawing. 

Qperatjon; After you have selected the Draw Text command from the Text & Dimension menu, highlight 
the Angle modifier in the <-Modify menu, and release the mouse button. You will then be prompted 
"Angle:"; type in the desired angle of the text, and press Return (if you make a mistake while typing the angle, 
you may use the Delete or Left Arrow keys to remove the error). Having entered the angle, you may now 
proceed with the command as you normally would (all text drawn from now on will appear with the specified 
angle, until you select another command). Please note that the angle will revert to its default value once you 
exit the Draw Text command (i.e. the next time you Draw Text without a modifier, the angle will be O 
degrees). 

Before 

• click 

Note: Angle= 90 degrees 

Draw Text Ang le 

Parameters; Angle (real o -359 degrees). 

Default Value; Angle = o degrees. 

Mw 
~ 
~ 
Cl) 

Cl) 

~ 

~ 1) If you press Return without entering a value for the angle, or enter an invalid value, the system will 
use the angle last specified. 

Left Justify 

The Left Justify modifier is used to modify the Draw Text command, and will allow you to left justify the text 
you are drawing. 

Qperatjon: After you have selected the Draw Text command from the Text & Dimension menu, highlight 
the Left Justify modifier in the <-Modify menu, and release the mouse button. You may now proceed with 
the command as you normally would, and the text will be placed to the left in relationship to where you click. 

Parameters: None. 

Default Value; None. 

Errors: None. 
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Center Justify 

The Center Justify modifier is used to modify the Draw Text command, and will allow you to center justify 
the text you are drawing. 

Operatjon; After you have selected the Draw Text comma nd from the Text & Dimension menu, highlight 
the Center Justify modifier in the <-Modify menu , and release the mouse button . You may now proceed 
with the command as you normally would, and the text will be placed in the center in relationship to where you 
click. Please note that the justification will revert to its default value once you exit the Draw Text command 
{i.e. the next time you Draw Text without a modifier, the justification will be left). 

Before Mm 

• click THIS IS TEXT 

Note: Text= TI-IIS IS TEXT 

Draw Text Center Justify 

Parameters: None . 

Default Value; None . 

~ None. 

Right Justify 

The Right Justify modifier is used to modify the Draw Text command , and will allow you to right justify the 
text you are drawing . Please note that the only time you will have to use this modifier is when you want to 
switch from the Left Justify or Center Justify modifier to the Right Justify modifier (i.e. Draw Text 
always assumes right justification unless you tell it otherwise). 

Operatjon: After you have selected the Draw Text command from the Text & Dimension menu, highlight 
the Right Justify modifier in the <·Modify menu , and release the mouse button. You may now proceed 
with the command as you normally would, and the text will be placed to the right in relationship to where you 
click. Please note that the justification will revert to its default value once you exit the Draw Text command 
(i.e. the next time you Draw Text without a modifier, the justification will be left). 
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Before 

• click 

Note: Text - THIS IS TEXT 

Draw Text Right Justify 

Parameters: None. 

Default Value: None. 

Errors; None. 
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Chapter 8 

EDIT MENU 

The Edit menu contains any commands that pertain to the alteration or replication of any basic entity (i.e. line, 
circle, arc, or point). By using the commands found in this menu, you will be able to save time utilizing graphic 
manipulation to duplicate and reposition drawing entities. Several of the commands discussed in this chapter 
may be further enhanced by using masks as explained in the Mask Menu chapter. 

After you have completed this chapter, you will be able to use the Trim Line, Trim Circle, Trim Arc, 
Move, Move Copy, Mirror, Mirror Copy, Rotate, Rotate Copy, Measure Angle, Measure 
Distance commands. 

Trim Line 

The Trim Line command is used to reloc.ate the end(s), and thereby the length, of an existing line. Please 
note that the Trim Line command is not limited to trimming a line shorter; you may also use it to extend an 
existing line. 

Operatjon: Highlight the Trim Line command in the Edit menu, and release the mouse button. Next, click 
once on the desired line, closest to the end you wish to trim. Finally, click the location where you would like the 
line to be trimmed to, and the resulting line will be drawn. 

Before 

Trim Line 

Parameters: None. 

Default Value: None. 

Errors: None. 

Trim Clrcle 

2nd click• 

The Trim Circle command is used to relocate the end(s), and thereby the angle, of an existing circle. Please 
note that it is important to remember that circles are trimmed in a counterclockwise manner. 
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operation: Highlight the Trim Circle command in the Edit menu, and release the mouse button. Next, click 
on the circle you wish to trim. Finally, click once on the circumference of the circle where you would like the trim 
to begin, and once where you would like the trim to end, and the resulting arc will be drawn. If, when selecting 
the circle to be trimmed you click on the beginning half, the resulting arc will go counterclockwise from the 
beginning of the trim to the end of the trim. However, if when selecting the circle to be trimmed you click on 
the ending half, the resulting arc will go counterclockwise from the end of the trim to the beginning of the trim. 

Before 

2nd click 

Trim Circle 

Parameters: None. 

Default Value: None. 

Trim Arc 

The Trim Arc command is used to relocate the end(s), and thereby the angle, of an existing arc. Please note 
that the Trim Arc command is not limited to trimming an arc shorter; you may also use it to extend an existing 
arc. Also, please note that it is important to remember that arcs are trimmed in a counterclockwise manner. 
Finally, please note that if you are having difficulty selecting an arc to trim, it may be useful to try clicking on 
either end of the arc. 

Operation; Highlight the Trim Arc command in the Edit menu, and release the mouse button. Next, click on 
the arc you wish to trim. Finally, click once on the circumference of the arc where you would like the trim to 
begin, and once where you would like the trim to end, and the resulting arc will be drawn. If, when selecting 
the arc to be trimmed you click on the beginning half, the resulting arc will go counterclockwise from the 
beginning of the trim to the end of the trim. However, If when selecting the arc to be trimmed you click on the 
ending half, the resulting arc will go counterclockwise from the end of the trim to the beginning of the trim. 

Before 
2nd click 
• 
1st click ( 

Trim Arc 
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parameters; None. 

,Default Value; None. 

Move 

The Move command is used to move an existing entity (i.e. line, circle, arc, or point) from its current position to 
a different location. Please note that it is worthwhile to review the following chapter Mask Menu to take full 
advantage of this command. 

Qperatjon; Highlight the Move command in the Edit menu, and release the mouse button. Next, click on the 
entity you wish to move. Now, click once on or near the entity you are moving to define a reference point, and 
once where you would like to relocate the reference point to (the direction and distance of movement is 
determined by the direction and distance between the two locations specified by your clicks). The entity will 
now be moved to the new location. 

Before 

Move 

Parameters: None. 

Default Value; None. 

Errors: None. 

Move Copy 

.2nd click 

3rd click. /0 

The Move Copy command is used to move a copy of an existing entity (i.e. line, circle, arc, or point) to a 
different location, leaving the original entity in place. Please note that this command is useful when you wish to 
repeat a particular entity throughout your drawing without having to redraw it each time. Also, please note that 
it is worthwhile to review the following chapter Mask Menu to take full advantage of this command. 

Qperatjon; Highlight the Move Copy command in the Edit menu, and release the mouse button. Next, click 
on the entity you wish to move. Now, click once on or near the entity you are moving to define a reference 
point, and once where you would like to relocate the reference point to (the direction and distance of 
movement is determined by the direction and distance between the two locations specified by your clicks). A 
copy of the original entity will now be moved to the new location. 
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Before 

Move Copy 

Parameters; None. 

Default Value: None. 

f.CCQm.; None. 

Mirror 

•2nd click 

3rd click. 

The Mirror command is used to mirror an existing entity (i.e. line, circle, arc, or point) about a specified axis. 
Please note that it is worthwhile to review the following chapter Mask Menu to take full advantage of this 
command. 

Operatjon-Highlight the Mirror command in the Edit menu, and release the mouse button. Next, click on the 
... ........ , entity you wish to mirror. Now, click twice is such a manner as to define the axis about which to mirror the entity. 

The entity will now be mirrored to the new location. 

Before 

Mirror 

Parameters; None. 

Default Value: None. 

f.a:o.rs.:. None. 
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Mirror Copy 

The Mirror Copy command is used to create a mirror image of an existing entity (i.e. line, circle, arc, or point) 
about a specified axis, r.eaving t~e o~ginal entity in place. Please note that this command is useful when you 
are creating a symmetrical drawing (1.e. draw one half of the drawing, then use the Mirror Copy command to 
automatically generate the other half). Also, please note that it is worthwhile to review the following chapter 
Mask Menu to take full advantage of this command. 

Operation: Highlight the Mirror Copy command in the Edit menu, and release the mouse button. Next, 
click on the entity you wish to mirror. Now, click twice is such a manner as to define the axis about which to 
mirror the entity. A copy of the original entity will now be mirrored to the new location. 

Before 

Mirror Copy 

Parameters: None. 

PetauH Value: None. 

~ None. 

Rotate 

The Rotate command is used to rotate an existing entity (i.e. line, circle, arc, or point) about a specified center 
of rotation. Please note that it is worthwhile to review the following chapter Mask Menu to take full advantage 
of this command. 

Operatjon: Highlight the Rotate command in the Edit menu, and release the mouse button. Next, click on 
the entity you wish to rotate. Now, click once to define the center of rotation, once to specify the starting angle 
of rotation, and once to specify the ending angle of rotation. The entity will now be rotated to the new location. 

Before • 
4th click 

2nd click 3rd click 
• • 

1st click 

Rotate 
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Rarameters: None. 

Default Yatue: None. 

~ None. 

~otate Copy 

The Rotate Copy command is used to rotate a copy of an existing entity (i.e. line, circle, arc, or point) about a 
specified center ot rotation, leaving the original entity in place. Please note that this command is useful when 
you wish to create rotated copies of an entity or entities at equally spaced angles with a constant distance from 
a specified center of rotation. Also, please note that it is worthwhile to review the following chapter Mask 
Menu to take full advantage of this command. 

Operation; Highlight the Rotate Copy command in the Edit menu, and release the mouse button. Next, 
click on the entity you wish to rotate. Now, click once to define the center of rotation, once to specify the 
starting angle of rotation, and once to specify the ending angle of rotation. A copy of the original entity will now 
be rotated to the new location. 

Before • 
4th click 

2nd click 
• 

1st click 

Rotate Copy 

Parameters: None. 

Default Value: None. 

~ None. 

Measure Angle 

3rd click 
• 

The Measure Angle command is used to measure the angle between an existing line and the horizon. 
Please note that this command will indicate both the acute and obtuse angle values. 

Operation: Highlight the Measure Angle command in the Edit menu, and release the mouse button. Now, 
click once on the line whose angle you are measuring. You will then be prompted "Acute: x Obtuse: y Press 
RETURN to continue.", where x equals the acute angle of the line in relationship to the horizon, and y equals 
the obtuse angle of the line in relationship to the horizon. Press Return when you are done viewing the angle. 

Parameters: None. 

Default Value: None. 

f[[QrS.;,None. 
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Measure Distance 

The Measure Distance command is used to measure the distance between two coordinates on your 
drawing. 

Operation; Highlight the Measure Distance command in the Edit menu, and release the mouse button. 
Now, click twice to define the distance you wish to measure. You will then be prompted "Distance x Press 
RETURN to continue .", where x equals the distance between the two coordinates specified in units. Press 
Return when you are done viewing the distance . 

Parameters; None. 

petault Value: None. 

~ None. 
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Chapter 9 
MASK MENU 

The Mask menu contains any masks that are used to limit selection during coordinate specification (i.e. 
clicking) to a particular area of the screen, position on the end of an existing entity (i.e. line, circle, arc, or point), 
or position in the center of an existing entity. Masks will work with practically any command that requires you to 
specify a coordinate or coordinates. Also included in this chapter are the masks necessary to specify 
coordinates using the Cartesian or polar coordinate systems. Masks are different from commands in that it is 
necessary to activate a command before you can use a mask. Masks are different from modifiers in that a mask 
will deactivate itseH after the command it is masking is used once, whereas a modifier will stay in effect for as 
long as you use the command It is modifying (this provides you with great flexibility when masking). Please 
note that masks may be used with both commands and modifiers; select the command first, then the modifier, 
then the mask. For example, you may wish to draw a line that is vertical, where one end of the line "snaps" to 
the end of an existing entity. Select the Draw Line command from the Entity menu, then the Vertical 
modifier from the <·Modify menu, and finally the End mask from the Mask menu. Now, when you specify 
the coordinates of the line, click once near the end of the existing entity you wish to snap to, and once where 
you would like the line to end. The vertical line will now be drawn, with one end attached to the end of the 
specified entity. 

After you have completed this chapter, you will be able to use the Window, End, Origin, Absolute, and 
Polar masks. 

Window 

The Window mask is used to specify a group of entities'for editing when using the Move , Move Copy, 
Mirror, Mirror Copy, Rotate, and Rotate Copy commands (you may recall that when used without the 
Window mask, the above commands will only edit one entity at a time). After you have specified the window, 
any entity contained within the window, and not touching the edge of the window, will be affected. Please 
note that arcs are treated are treated as circles in determining if they are in the window; if you have an arc with a 
very large radius, you will have to define your window so that it encompasses the arc's entire radius in all 
directions (i.e. pretend the arc is a circle). Also, please note that the Window mask will deactivate itself after 
the command it is masking is used once; simply reselect the mask to reactivate it. 

Operatjon: After you have selected the Move, Move Copy, Mirror, Mirror Copy, Rotate, or Rotate 
Copy command from the Edit menu, highlight the Window mask in the Mask menu, and release the 
mouse button. Next, instead of clicking on the entity you wish to edit as you normally would for any of the 
commands above, click twice in such a manner that the coordinates you have specified will define a rectangle, 
or "window", around the entities you wish to edit. Having placed the window around the entities you wish to 
edit, you may now proceed with the command as you normally would, and all entities completely within the 
specif led window not touching the edge will be edited accordingly. 
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Before 
.1st click 

Move Window 

Parameters: None. 

Default Value: None. 

f.r.r.Qra;. None. 

End 

4th click• 0 

The End mask is used to select the end point of an existing entity (i.e. line, circle, arc, or point) by clicking 
anywhere near the half of the entity closest to the end desired. The end of an entity is defined as follows: The 
end of a line is either endpoint, the end of a circle is O degrees on the circumference, the end of an arc is 
either endpoint, and the end of a point is its center. The End mask will affect virtually any command that 
requires coordinate specification (i.e. clicking). 

Operation; After you have selected the desired command from its corresponding menu, highlight the End 
mask in the Mask menu, and release the mouse button. You may now proceed with the command as you 
normally would, however, when specifying the first coordinate of the command, click once near the end of the 
existing entity you wish to snap to; once you complete the command, the first coordinate will be aligned with 
the end of the specified entity accordingly. Please note that if you wish to align a coordinate other than the 
one specified by the first click, simply select a mask after the first coordinate has been specified, and before 
the desired coordinate has been clicked. 

Before 

1st click 

.2nd click 

Draw Line End 

This diagram shows the effect of the End mask when snapping to the end of a circle. 
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Parameters: None. 

Default vatue: None. 

Errors: None. 

Origin 

The Origin mask is used to select the center, or "origin" of an existing entity (i.e. line, circle, arc, or point) by 
clicking anywhere on the desired entity. The origin of an entity is defined as follows: The origin of a line is its 
midpoint, the origin of a circle is its center, the origin of an arc is its center, and the origin of a point is its center. 
The Origin mask will affect virtually any command that requires coordinate specification (i.e. clicking). 

Operation: After you have selected the desired command from its corresponding menu, highlight the Origin 
mask in the Mask menu, and release the mouse button. You may now proceed with the command as you 
normally would, however, when specifying the first coordinate of the command, click once on the existing 
entity you wish to snap to; once you complete the command, the first coordinate will be aligned with the origin 
of the specified entity accordingly. Please note that if you wish to align a coordinate other than the one 
specified by the first click, simply select the mask after the first coordinate has been specified, and before the 
desired coordinate has been clicked. 

Before 

1st click 

2nd click• 

Draw Line Origin 

This diagram shows the effect of the Origin mask when snapping tQ the origin of a line. 

parameters: None. 

Default Value: None. 

Errors: None. 

Absolute 

The Absolute mask is used to specify the explicit location of a coordinate using the Cartesian coordinate 
system, and will affect virtually any command that requires coordinate specification (i.e. clicking). In the 
Cartesian coordinate system, a coordinate is specified by a pair of X Y values, describing a given location in 
terms of its horizontal and vertical distance from a fixed point of reference called the origin {i.e. X = O, Y = 0). 
Please note that when you first start the discoverCAD system, the origin is located in the exact center of the 
screen (zooming or panning may shift where the origin appears on the screen). 

9 - 3 



Operat;on: After you have selected the desired command from its corresponding menu, highlight the 
Absolute mask in the Mask menu, and release the mouse button. You may now proceed with the command 
as you normally would, however, when specifying the first coordinate of the command you will be prompted 
"X:"; type in the desired X value and press Return. You will then be prompted "Y:"; type in the desired Y value 
and press Return. If you make a mistake while typing x or Y, you may use the Delete or Left Arrow keys to 
remove the error. If you press Return without entering a value for either X or Y, the system will not proceed with 
the command. Please note that if you wish to align a coordinate other than the one specified by the first click 
(or in addition to it), simply select the mask after the first coordinate has been specified, and before the desired 
coordinate has been clicked. 

(-X,+Y) (+X,+Y) 

(X=O,Y=O) 

----tr---- Xaxis 

(-X,-Y) (+X,-Y) 
Yaxis 

Cartesian Coordinate System 

Parameters: 1) X (real> -1001 and< 1001). 2) Y (real> -1001 and< 1001). 

Default Value: None. 

~ 1) When specifying a coordinate with a X or Y value greater than 1000, or less than -1000, the resulting 
display may be unreliable. 

Polar 

The Polar mask is used to specify the explicit location of a coordinate using the polar coordinate system, and 
will affect virtually any command that requires coordinate specification (I.e. clicking). In the polar coordinate 
system, a coordinate is specified by the direct distance of the position from the origin in combination with the 
angle of the position from the origin measured in a counterclockwise direction from the horizontal. Please note 
that when you first start the discoverCAD system, the origin is located in the exact center of the screen 
(zooming or panning may shift where the origin appears on the screen). 

Operation: After you have selected the desired command from its corresponding menu, highlight the Polar 
mask in the Mask menu, and release the mouse button. You may now proceed with the command as you 
normally would, however, when specifying the first coordinate of the command you will be prompted 
"Radius:"; type in the desired value for the radius and press Return. You will then be prompted "Angle:"; type 
In the desired value for the angle and press Return. If you make a mistake while typing the radius or angle, you 
may use the Delete or Left Arrow keys to remove the error. If you press Return without entering a value for 
either the radius or angle, the system will not proceed with the command. Please note that If you wish to align a 
coordinate other than the one specified by the first click (or in addition to it), simply select the mask after the 
first coordinate has been specified, and before the desired coordinate has been clicked. 
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Parameters; 1) Radius (real> -1001 and< 1001). 2) Angle (real o -359 degrees). 

Default Value; None. 

fD:Qrs.; 1) When specifying a coordinate with a radius greater than 1000, or less than -1000, the resulting 
display may be unreliable. 
2) If a negative number is entered for the angle, the absolute value of that number will be used in its place. 
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Chapter 10 
PLOT MENU 

The Plot menu contains any commands that pertain to the output of your drawing. You may plot to one of the 
graphics plotters listed below, or print to a variety of serial and parallel dot matrix printers. Plotting will provide 
you with the most desirable hardcopy quality, whereas the dot matrix printer will be somewhat less exact in 
appearance. Please note that it is worthwhile to review the Plot Tutorlal and Technlcal Notes 
appendices to take full advantage of these commands. 

After you have completed this chapter, you will be able to use the Plotter, Apple, Roland DXV, HI 
PC695, HI DMP40, HI DMP41, HP7470, HP7475, Pen Number, Dim Scale, and Printer 
commands. 

Plotter 

The Plotter command is used to specify whether or not you want the output to go to the screen or the 
plotter. 

Operatjon: Highlight the Plotter command in the Plot menu, and release the mouse button. The output will 
now be sent to the plotter instead of the screen (when plotter is on, the command will have a check mark next 
to it in the Plot menu). To turn the plotter off, simply reselect the Plot command (please note that the 
Plotter command will automatically shut itself off after the Redraw or Draw Layer command has been 
issued). 

Parameters: On/Off. 

Default Value; Plotter= Off. 

~None. 

Apple 

The Apple command is used to specify the Apple 41 O Color Graphics Plotter as the plotter you will be using 
during plotting. 

Operation: After you have selected the Plotter command from the Plot menu (i.e. plotter is on), highlight 
the Apple command in the Plot menu, and release the mouse button. You will then be prompted "Paper 
size A or B"; type in the desired paper size, and press Return (if you make a mistake while typing the paper 
size, you may use the Delete or Left Arrow keys to remove the error). The system will then initialize the plotter 
for the plotting process. 

Parameters: Paper size (A or B). 

Default \fafue: None. 

~ 1) If you try to type the paper size and nothing appears, make sure the Caps Lock key is depressed. 
2) The system will continue to prompt you until a valid paper size is entered. 
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Roland DXV 

The Roland DXY command is used to specify the Roland oxv 880, DXY 980, or DXY 1100 graphics plotter 
as the plotter you will be using during plotting (these plotters have been tested and are known to work; other 
Roland plotters that have not been tested may work as well). 

Operatjon; After you have selected the Plotter command from the Plot menu (i.e. plotter is on), highlight 
the Roland DXV command in the Plot menu, and release the mouse button. You will then be prompted 
"Paper size A or B"; type in the desired paper size, and press Return (if you make a mistake while typing the 
paper size, you may use the Delete or Left Arrow keys to remove the error). The system will then initialize the 
plotter for the plotting process. 

Parameters; Paper size (A or B). 

Default Value: None. 

~ 1) If you try to type the paper size and nothing appears, make sure the Caps Lock key is depressed. 
2) The system will continue to prompt you until a valid paper size is entered. 

HI PC695 

The HI PC695 command is used to specify the Houston Instrument PC695, PC695A or PC595 graphics 
plotter as the plotter you will be using during plotting. Please note that if you are using the PC595 plotter, you 
must specify A as the paper size. 

Operation; After you have selected the Plotter command from the Plot menu {i.e. plotter is on), highlight 
the HI PC695 command in the Plot menu, and release the mouse button. You will then be prompted "Paper 
size A or B"; type in the desired paper size, and press Return (if you make a mistake while typing the paper 
size, you may use the Delete or Left Arrow keys to remove the error}. The system will then initialize the plotter 
for the plotting process. 

Parameters: Paper size (A or B). 

Default Value: None. 

~ 1) If you try to type the paper size and nothing appears, make sure the Caps Lock key is depressed. 
2) The system will continue to prompt you until a valid paper size is entered. 

HI DMP40 

The HI DMP40 command is used to specify the Houston Instrument DMP40 graphics plotter as the plotter 
you will be using during plotting. Please note that this command can be used to activate any other HI DMP 
series A/B plotter. 

Operatjon; After you have selected the Plotter command from the Plot menu (i.e. plotter is on), highlight 
the HI DMP40 command in the Plot menu, and release the mouse button. You will then be prompted 
"Paper size A or B"; type in the desired paper size, and press Return (if you make a mistake while typing the 
paper size, you may use the Delete or Left Arrow keys to remove the error}. The system will then initialize the 
plotter for the plotting process. 

Parameters: Paper size (A or B). 

Default varue: None. 
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~ 1) If you try to type the paper size and nothing appears, make sure the Caps Lock key is depressed. 
2) The system will continue to prompt you until a valid paper size is entered. .. 

HI DMP41 

The HI DMP41 command is used to specify the Houston Instrument DMP41 graphics plotter as the plotter 
you will be using during plotting. Please note that this command can be used to activate any other HI DMP 
series CID plotter. 

Operatjon; After you have selected the Plotter command from the Plot menu (i.e. plotter is on), highlight 
the HI DMP41 command In the Plot menu, and release the mouse button. You will then be prompted 
"Paper size C or D"; type In the desired paper size, and press Return (if you make a mistake while typing the 
paper size, you may use the Delete or Lett Arrow keys to remove the error). The system will then initialize the 
plotter for the plotting process. 

parameters; Paper size (C or D). 

Default Value: None. 

~ 1) If you try to type the paper size and nothing appears, make sure the Caps Lock key is depressed. 
2) The system will continue to prompt you until a valid paper size is entered. · 

HP7470 

The HP 7470 command is used to specify the Hewlett Packard 7470 graphics plotter as the plotter you will 
be using during plotting. 

Operation; After you have selected the Plotter command from the Plot menu (i.e. plotter is on), highlight 
the HP 7470 command in the Plot menu, and release the mouse button. The system will then initialize the 
plotter for the plotting process. 

Parameters: None. 

Default Value; None. 

Errors: None. 

HP7475 

The HP 7475 command is used to specify the Hewlett Packard 7475 or 7440A Color Pro graphics plotter as 
the plotter you will be using during plotting. 

Qperatjon; After you have selected the Plotter command from the Plot menu (i.e. plotter is on), highlight 
the HP 7475 command in the Plot menu, and release the mouse button. You will then be prompted "Paper 
size A or B"; type in the desired paper size, and press Return (if you make a mistake while typing the paper 
size, you may use the Delete or Left Arrow keys to remove the error). The system will then initialize the plotter 
for the plotting process. 

Parameters: Paper size (A or B). 

Default Value; None. 
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~ 1) If you try to type the paper size and_nothin_g appea~, m~ke sure the Caps Lock key is depressed. 

2) The system will continue to prompt you until a vahd paper size 1s entered. 

Pen Number 

The Pen Number command is used to specify which pen to use during plotting should your plotter have 
multi-pen capability. 

Operation: After you have selected the Plotter command from the Plot menu (i.e. plotter is on), and have 
selected the appropriate plotter type (ex. Apple}, highlight the Pen Number command in the Plot menu, 
and release the mouse button. You will then be prompted "Pen Number:"; type in the desired pen number, 
and press Return (if you make a mistake while typing the pen number, you may use the Delete or Left Arrow 
keys to remove the error). If you press Return without entering a value for the pen number, the system will exit 
the Pen Number command. The plotter will now select the indicated pen. 

Parameters: Pen Number (integer 1 - 8). 

Default Value: None. 

~ 1) If you don't specify a valid pen number (i.e. 1 - 8), the system will ignore what you have entered). 

Dim Scale 

The Dim Scale command is used to scale any dimensioning you may have In your drawing separately from 
the rest of the entities. This command is useful when your drawing has been zoomed extensively prior to 
plotting or printing, and the dimensioning text appears too large or too small In relationship to the rest of the 

, drawing. Please note that the time it takes to redraw the screen after scaling the dimensioning may be lengthy, 
especially when your drawing contains a lot of dimensioning. 

Qperatjon: Highlight the Dim Scale command in the Plot menu, and release the mouse button. You will 
then be prompted "Scale,:"; type in the desired scaling of the dimensioning, and press Return (ex. if you want 
the dimensioning twice as big, type In a scale of 2; if you want the dimensioning twice as small, type in a scale 
of 0.5). If you make a mistake while typing the scale, you may use the Delete or Left Arrow keys to remove the 
error. If you press Return without entering a value for the scale, the system will exit the Dim Scale command. 
The screen will now be redrawn, with the dimensioning scaled accordingly. 

parameters; Scale (real> o and< 1001). 

Default Value; None. 

~ 1} If a negative number is entered for the scale, the absolute value of that number will be used in its 
place. 
2) When scaling with a ratio greater than 1000, the resulting display may be unreliable. 

Printer 

The Printer command is used to print your drawing to a dot matrix printer. Please note that discoverCAD 
requires the use of Beagle Brother's Triple Dump software for this command. Also, please note that you 
should save your drawing using the Save command found in the File menu before using this command, as 
you will not be able to retrieve your dra•:i rng after printing if it has not been saved to disk. 
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Ogeratjon: Highlight the Printer command in the Plot menu, and release the mouse button. You will then be 
prompted "WARNING: Wish to save drawing before printing? (YIN)". If you press Y, the system will exit the 
Printer command, thereby allowing you the chance to save your drawing before printing. If you press N, you 
will then be prompted "Replace discoverCAD disk(s) with Triple Dump disk, then press RETURN."; remove the 
discoverCAD system disk(s), insert the Triple Dump DOS 3.3 disk into the startup disk drive, and press Return. 
You will then be prompted "WARNING: Wish to reboot system now? (YIN)". If you press N, the system will exit 
the Printer command. If you press y, the computer will restart itself, after which time Triple Dump will be 
loaded and running (your discoverCAO drawing will still reside in the computer's memory). You may now 
proceed with the Triple Dump program as you normally would to print the drawing (see Triple Dump owner's 
manual). 

Parameters: None. 

Default Value: None. 

~ 1) If you try to type a reply and nothing appears, make sure the Caps Lock key is depressed. 
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Appendix A 
DRAW TUTORIAL LEVEL 1 

In this tutorial you will be shown step by step how to draw a simple mechanical drawing using several of the 
basic discoverCAD commands. Among the commands featured are Draw Grid, Snap Grid, Draw Line, 
Draw Rectangle, and Draw Clrcle with the Radius modifier. 

Before you begjn thjs procedure, please refer to the Introduction chapter to familiarize yourself with basic 
command and coordinate selection This tutorial assumes you have properly configured your computer, know 
how to start the discoverCAD system, and are familiar with the use of the mouse and menus. 

Directions 

The purpose of this tutorial is to construct the drawing depicted in the ~diagram of step 5; simply follow 
the steps below in order to achieve the final drawing. Each step has an general overview of what the command 
can be used for, and how to use it. Also included is an illustration of what the screen should look like before 
and after you use the command . When entering a coordinate for a command (i.e. clicking the mouse button), 
see the~ screen for the proper location of your click{s) (count the grid dots in each diagram to make your 
drawing 'appear exactly as in the diagrams). The symbols C1, C2, C3, etc. will represent your 1st click, 2nd 
click, and 3rd click, etc. respectively. If you make a mistake during a procedure , you may need to use the 
Erase command to correct it (see the Entity Menu chapter for use of the Erase command) . If you need 
additional information on the operation or effect of a command, refer to the appropriate location in this manual. 

Step 1 - Draw Grid and Snap Grid 

The Draw Grid command is used to display a series of evenly spaced rows and columns of dots . Used in 
conjunction with the Snap Grid command, the Draw Grid command is useful when the accuracy of a 
drawing is important. Highlight the Draw Grid command in the Screen menu, and release the mouse 
button. You will then be prompted "Grid Size?" ; enter a value of 1, then press Return. The grid will now be 
drawn on the screen. 

Before M1Jll 

. 

Note: Grid Size= 1 

Step 1 . Draw Grid and Snap Grid 

The Snap Grid command is used to "snap" a coordinate to the grid system (your clicks will automatically snap 
to the nearest grid dot). Highlight the Snap Grid command in the Screen menu, and then release the 
mouse button. The snapping feature will now be in effect. 
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Step 2 - Draw Rectangle 

The Draw Rectangle command is used to draw rectangles of any shape or size. Highlight the Draw 
Rectangle command in the Entity menu, and release the mouse button . Next , click twice (C1, C2) in such a 
manner that the coordinates you have specified will define the rectangle you desire. The rectangle will be 
drawn accordingly. · 

Before 

. . . . . ..•. 
2nd click (C2) 

Step 2 - Draw Rectangle 

Step 3 - Draw Line 

The Draw Line command is used to draw a straight line between two coordinates . Highlight the Draw Line 
command in the Entity menu , and release the mouse button . Next click once (C1) where you would like the 
line to begin . and once (C2) where you would like it to end. The line will now be drawn between the two 
coordinates . Continue drawing the next two lines, clicking at C3, C4 and CS, CS respectively. 

Before 

-C6 -----

C2 . . . 
C3 

. cs 
• 

C4 

Step 3 - Draw Line 

Step 4 - Draw Circle 

The Draw Clrcle command is used to draw circles. Highlight the Draw Circle comm and in the Entity 
menu. and release the mouse button. Next, click throe times (C1, C2, C3) in such a manner as to def ine the 
circumference of the circle. The circle will be drawn, passing through the three coordinates you have 
specified . 
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Before 

.. 
C2 • . ·r.~ 

Step 4 - Draw Clrcle 

0 

Step 5 - Draw Circles with a Radius modifier 

The Radius modifier is used to modify the Draw Circle and Draw Arc commands , and will allow you to 
specify the exact radius of a circle or arc. After you have selected the Draw Circle command from the Entity 
menu, highlight the Radius modifier in the <·Modify menu, and release the mouse button . Next click once 
(C1) where you would like the center, or "origin", of the circle to be. You will be prompted "Radius?"; enter a 
value of .5 , and press Return. The circle will now be drawn according to the specified radius. Continue by 
drawing the second circle clicking at C2, then entering a value of .5 for the Radius. 

Before ~ 

0 0 
·c·1 · c2• O · ·O 

Note: Radius -= .5 

Step 5 -Draw Circles with a Radius modifier 

You have now completed Draw Tutorial Level 1. Proceed with the following tutorial to experience some of 
the more advanced features of discoverCAD. 
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DRAW TUTORIAL LEVEL 2 

In this tutorial you will be shown step by ste~ how to draw a simple isometric cube with an ellipse, and in the 
process learn several irrtportant CAD techniques . Among the commands featured are Zoom Origin, Zoom 
Window, oraw Line with the None , Length , Vertlcal , Horizontal, Parallel, and Angle modifiers, 
Erase Line, Draw Arc with the Radius modifier, Draw Point with the Intersect modifier, Erase Point, 
Draw Linear Dim with the Vertlcal and Point to Point modifiers, Move Copy, and End and Origin 
masking. 

Before you begin this procedure, please refer to the Introduction chapter to familiarize yourseH with basic 
command and coordinate selection. This tutorial assumes you have properly configured your computer, know 
how to start the discoverCAD system, and are familiar with the use of the mouse and menus. 

Step 1 

Select the Draw Line command from the Entity menu, then the Horlzontal modifier from the first 
c-Modlfy menu. Draw a small horizontal line near the lower left comer of the screen to serve as a reference 
for the Draw Line Angle command as used in the steps that follow. 

Before MJ..fil 

1st click 
• • -

2nd click 

Step 1 

Step2 

Select both the Angle modifier, then the Length modifier from the first <·Modify menu. Click once on the 
horizontal line you created in step 1 above. Enter a value of 30 degrees for the angle, then press Return. Click 
once near the lower middle of the screen. Enter a value of 4 for the length, then press Return. Click once near 
the upper right corner of the screen to draw the first line of the cube. 

Befora, After 
3rd click. 

-1st click 
• 2nd click - ~ 

Step 2 
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Step3 

Click once on the horizontal line you created in step 1 above. Enter a value of 150 degrees for the angle, then 
press Return. Select the End mask from the Mask menu. Click once near the bottom end of the 30 degree 
line you created in step 2 above. Enter a value of 4 for the length; then press Return. Click once near the 
upper left corner of the screen. 

Before Mm[ 

•3rd click 

- ~ -~ 
1st click 

Step 3 

Step4 

Select the Vertlcal modifier from the first <-Modify menu. Select the End mask from the Mask menu. Click 
once near the intersection of the two lines you created in steps 2 and 3 above. Enter a value of 4 for the 
length, then press Return. Click once near the upper middle of the screen. 

Before 
•2nd click 

-~ 1st click 

Step 4 

Steps 

Select the Parallel modifier from the first <-Modify menu. Click once on the 30 degree line you created in 
step 2 above. Select the End mask from the Mask menu. Click once near the top end of the vertical line you 
created in step 4 above. Enter a value of 4 for the length, then press Return. Click once near the upper right 
corner of the screen. 
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Before. 3rd click• 

2nd click. 

Step 5 

Step6 

Click once on the 150 degree line you created in step 3 above. Select the End mask from the Mask menu. 
Click once near the top end of the vertical line you created in step 4 above. Enter a value of 4 for the length, 
then press Return . Click once near the upper left corner of the screen . 

Before 
•3rd click 

Step 6 

Step7 

Select both the None modifier, then the Length modifier from the first <·Modify menu. Select the End 
mask from the Mask menu. Click once near the right end of the 30 degree line you created in step 2 above. 
Select the End mask from the Mask menu. Click once near the right end of the parallel line you created in 
step 5 above. 

Before 

1st click 

Step 7 
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Steps 

Select the End mask from the Mask menu. Click once near the left end of the 150 degree line you created in 
step 3 above. Select the End mask from the Mask menu. Click once near the left end of the parallel line you 
created in step 6 above. 

1st click 

Step 8 

Step9 

Select the Move Copy command from the Edit menu. Click once on the parallel line you created in step 5 
above. Select the End mask from the Mask menu. Click once near the left end of the parallel line you created 
in step 5 above. Select the End mask from the Mask menu. Click once near the top end of the line you 
created in step 8 above. 

Before 

Step 9 

Step 10 

Click once on the parallel line you created in step 6 above. Select the End mask from the Mask menu. Click 
once near the right end of the parallel line you created in step 6 above. Select the End mask from the Mask 
menu. Click once near the top end of the line you created in step 7 above. 
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Before 

Step 10 

Step 11 

Select the Erase Line command from the Entity menu. Click once on the horizontal line you created in step 
1 above. 

-click 

Step 11 

Step 12 

Select the Zoom Window command from the Screen menu. Click twice in such a manner as to define a 
"window" that will surround the top of the isometric cube. 

2nd click• 

Step 12 
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Step 13 

Select the Draw Line command from the Entity menu. Select the End mask from the Mask menu. Click 
once near the vertical line you created in step 4 above. Select the Origin mask from the Mask menu. Click 
once on the line you created in step 9 above. Select the End mask from the Mask menu. Click once near the 
vertical line you created in step 4 above. Select the Origin mask from the Mask menu. Click once on the line 
you created in step 1 o above. 

Before 

1 st click • • 3rd click 

Step 13 

Step 14 

Select the End mask from the Mask menu. Click once near the intersection of the two lines you created in 
steps 9 and 10 above. Select the Origin mask from the Mask menu. Click once on the parallel line you 
created in step 5 above. Select the End mask from the Mask menu. Click once near the intersection of the 
two lines you created in steps 9 and 10 above. Select the Origin mask from the Mask menu. Click once on 
the parallel line you created in step 6 above. 

Before 

Step 14 

Step 15 

Select the Draw Point command from the Entity menu, then the Intersect modifier from the first 
<-Modify menu. CIiek once on first line you created in step 13 above. Click once on second line you created 
in step 14 above. Click once on second line you created in step 13 above. Click once on first line you created 
in step 14 above. 
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Step 15 

Step 16 

Select the Erase Line command from the Entity menu. Click once on each of the four lines you created in 
steps 13 and 14 above. 

Step 16 

Step 17 

Select the Draw Arc command from the Entity menu, then the Radius modifier from the first <-Modify 
menu. Select the End mask from the Mask menu. Click once near the vertical line you created in step 4 
above. Press Return without entering a value for the radius. Select the Origin mask from the Mask menu. 
Click once on the line you created in step 1 O above. Select the Origin mask from the Mask menu. Click once 
on the line you created in step 9 above. 

Before 

Step 17 
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Step 18 

Select the End mask from the Mask menu. Click once near the intersection of the two lines you created in 
steps 9 and 10 above. Press Return without entering a value for the radius. Select the Origin mask from the 
Mask menu. Click once on the parallel line you created in step 6 above. Select the Origin mask from the 
Mask menu. Click once on the parallel line you created in step 5 above. 

Before 

Step 18 

Step 19 

Select the Origin mask from the Mask menu. Click once near the right most point you created in step 15 
above. Press Return without entering a value for the radius. Select the Origin mask from the Mask menu. 
Click once on the parallel line you created in step 5 above. Select the Origin mask from the Mask menu. Click 
once on the line you created in step 1 O above. 

Before 

Step 19 

Step 20 

Select the Origin mask from the Mask menu. Click once near the left most point you created In step 15 
above. Press Return without entering a value for the radius. Select the Origin mask from the Mask menu. 
Click once on the line you created in step 9 above. Select the Origin mask from the Mask menu. Click once 
on the parallel line you created in step 6 above. 
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Step 20 

Step 21 

Select the Erase Point command from the Entity menu. Click once on each of the points you created in 
step 15 above. 

Before 

Step 21 

Step 22 

Select the Zoom Origin command from the Screen menu. 

Before 

Step 22 

Step 23 

Select the Draw Linear Dim command from the Text & Dimension menu, then the Vertlcal modifier 
from the second <-Modify menu. Click once near the bottom end of the line you created in step 7 above. 
Click once near the top end of the line you created in step 7 above. Click once where you would like the 
dimension text to be placed. 
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Before 

Step 23 

Step 24 

• 
lick 

l :r 

Select the Point to Point modifier from the second <-Modify menu. Click once near the left end of the line 
you created in step 2 above. Click once near the right end of the line you created in step 2 above. Click once 
where you would like the dimension text to be placed . 

• 
1st click 3rd click 

Step 24 

As you can see from this example, discoverCAD allows you great flexibility when creating and modifying 
drawings. Now that you have this simple drawing completed, try expeirimenting with some of the other 
discoverCAD commands to see what you can create on your own. 

A- 13 



Appendix B 
SYMBOL TUTORIAL 

In this tutorial you will be shown step by step how to create and utilize a simple symbol file, and in the process 
learn several important discoverCAD techniques. Among the commands featured are Save, Merge, 
Symbol, Draw Grid, Snap Grid, Use Layer, Erase Layer, Draw Line, Draw Rectangle, Draw 
Circle with a Radius modifier, Draw Arc with a Radius modifier, and Erase All. 

Before you begjn this procedure, please refer to the Introduction chapter to familiarize yourseH with basic 
command and coordinate selection, and the Draw Tutorial appendix to acquaint yourseH with the creation of 
basic entities (i.e. lines, circles, arcs, points). This tutorial assumes you have properly configured your 
computer, know how to start the discoverCAD system, are familiar with the use of the mouse and menus, and 
know how to draw basic entities. It is also advisable to review the FIie Menu chapter before you begin. 

Directions 

The purpose of this tutorial is to construct the drawing depicted in the Ml:! diagram of step 90; simply follow 
the steps below in order to achieve the final drawing. Each step has an general overview of what the command 
can be used for, and how to use it. Also included is an illustration of what the screen should look like before 
and after you use the command. When entering a coordinate for a command (i.e. clicking the mouse button), 
see the~ screen for the proper location of your click(s) (count the grid dots in each diagram to make your 
drawing appear exactly as in the diagrams). The symbols C1, C2, C3, etc. will represent your 1st click, 2nd 
click, and 3rd click, etc. respectively. If you make a mistake during a procedure, you may need to use the 
Erase command to correct it (see the Entity Menu chapter for use of the Erase command). If you need 
additional information on the operation or effect of a command, refer to the appropriate location in this manual. 

Before you begin the steps below, you may wish to format a blank disk at this time if you have not already done 
so, or one has not been provided for you; one will be needed to save your symbol file to once its completed 
(see the File Menu chapter for more on the Format command). 

Step 1 - Fresh Start 

When creating a symbol file from scratch, it is advisable to start right after you have booted the discoverCAD 
software; that way, you are assured that none of the discoverCAD parameters have been changed in such a 
manner as to interfere with the creation of your symbol file. For this step boot the discoverCAD software as you 
normally would. Then, select the Draw Grid command from the Screen menu, and enter a value of 1 for the 
Grid Size. Finally, select the Snap Grid command to "snap"all of your coordinate entries (i.e. clicking the 
mouse button) to the grid dots. 

Step 2 - Defining the Symbol Table Layer 

Before you begin creating the symbols, it is important to decide which layer you want them to reside on. 
Typically, you will want to start drawing the symbols on the very last layer of the symbol file (i.e. layer 128), and 
work your way down from there. The logic behind this is that when you create a drawing file, you usually start 
with layer 1 and work your way up; when creating the symbol file, you want to do the exact opposite to insure 
that the layers of the symbol file will not overlap the layers of your drawing file once you Merge the two 
together. The Merge command will combine, or "merge" a previously saved symbol file with your current 
working drawing. If your symbol file has symbols on layer 127 and 128, those symbols will be merged over 

· layer 127 and 128 of you working drawing (more on the Merge command later). 
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The use Layer command is used to specify which layer to use when drawing. Select the Use Layer 
command from the Screen menu. Enter a value of 128 for the layer, then press Return. From now on, any 
drawing you do will be contained on layer 128 until you select Use Layer and specify a different value. 
Step 3 • Creating Rectangular Symbols 

You may now create the symbols that you want to reside on layer 128. When drawing symbols, you can use 
any discoverCAD command with the exception of those found in the Text & Dimension menu; a symbol file 
must never, repeat never, contain text or dimensioning. Additionally, you will usually want to group symbols of 
a similar nature on the same layer. With this in mind, select the Draw Rectangle command from the Entity 
menu, and draw three rectangles clicking once each at C1 and C2, C3 and C4, and CS and C6, respectively 
(obviously these "symbols" could be much more complex, but for this example rectangles will suffice). 

Before 

:c:1~ 

: ~q2: 
[J ··o· .. 

. . 

:cs~: 

Step 3 • Drawing Rectangular Symbols 

Step 4 • Creating Circular Symbols 

Now, supposing you wanted to draw some other symbols on layer 127, you would start by removing layer 128 
from the display, select Use Layer with a value of 127, then draw your symbols. 

The Erase Layer command is used to temporarily remove a layer from the current screen display. Please 
note that this command does not actually erase the layer, but merely hides it from view. Select the Erase 
Layer command from the Screen menu and enter a value of 128, then press Return. Layer 128 is now 
hidden from view. Continue by selecting the Use Layer command from the Screen menu. Enter a value of 
127 for the layer, then press Return. You may now create the symbols you want to reside on layer 127. Select 
the Draw Circle command from the Entity menu and then select the Radius modifier from the <-Modify 
menu. Now, draw three circles clicking at C1, C2, and C3 for their center points and entering values of 1, 1.5, 
and .5 respectively for their radii. (again, these "symbols" could be much more complex, but for this example 
circles will suffice). 

Before 

ci ~ : : c2 ~ 0 . . ·o· . . 
. . 

·O· 

Step 4 • Drawing Circular Symbols 
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Step 5 • Saving a Symbol FIie 

Now that you have created your symbols, you will want to save them as a symbol file. A symbol file is exactly the 
same as a drawing file, with the exception that the symbol file contains individual symbols rather than a 
drawing. 

The Save command is used to store a drawing or symbol file that you have created with discoverCAD onto a 
disk that has been formatted with discoverCAD. Select the Save command from the FIie menu. You will then 
be prompted "Place drawing disk in drive #X:, then press Return." (where x represents the disk drive being 
used for the File Menu commands). Insert a formatted disk, and press Return. You will then be prompted "File · 
name:". For this example name your symbol file SYM-127; by using this notation, you will know that the file 
contains symbols down to layer 127 (i.e. SYM designates symbol and 127 designates where the last layer of 
symbols reside). If you make a mistake while typing the filename, you may use the Delete or Left Arrow keys to 
remove the error. Now press Control a to enter the filename (depress the Control and a key at the same time). 
The symbol table will now be saved. Once the symbols have been saved, you may be prompted "Replace 
discoverCAD system disk 1 in drive #1; then press Return.". Replace the drawing disk with the discoverCAD 
system disk you may have removed, and press Return to resume discoverCAD. 

Step 6 • Starting with a Clean Slate 

At this point you would normally have one of two options. You could either use the Edit command from the 
File menu to recall an existing drawing file to which you want to add symbols, or start a new drawing from 
scratch, then add the symbols. In either case you must first reset discoverCAD to its original startup state (i.e. 
clean slate). Select the Erase Layer command to remove layer 127 from the display, then select the Use 
Layer command to specify that you want to use layer 1 as the active drawing layer. Finally, perform the 
following to clear the screen of everything except the grid. 

The Erase All command is used to permanently erase your entire drawing from the display. Select the 
Erase All command from the Entity menu, type in "Y" at the prompt. and the entire drawing will be erased 
from the screen, giving you a clean slate with which to draw (layers 127 & 128 as used in the steps above will 
be erased). 

For the remainder of this tutorial , lets assume that you want to create a drawing from scratch, and then add a 
few of the symbols you created in the steps above. 

Step 7 • Starting your Working Drawing 

At this time the grid should be the only thing you see on your screen. Also, there should be a check mark next 
to the Snap Grid command in the Screen Menu indicating that it is turned on. To begin your drawing, simply 
select the Draw Line command and draw four lines as indicated below, clicking once each at C1 and C2, C3 
and C4, CS and C6, and C7 and ca, respectively. 

Before 
. . . . . . ..... 
. . . . c.1. .c2 ... 
: C3: ~ ~: ···er . . . . 

. C4 ... . . .. : : ~ca: . . . . . ... 
C5- cs. 

Step 7 • Working Drawing (Draw Line) 
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Next select the Draw Arc command with a Radius modifier and draw four arcs as indicated below. Click at 
c1 f~r the center point of the 1st arc, and press Return when prompted for a radius. Complete the arc by 
clicking at c2 for the beginning point and at C3 for the end point. Click at C4 for the center point of the 2nd arc 
and press Return when prompted for a radius. Complete the arc by clicking at CS for the beginning point and 
at cs for the end point. Continue to do this for the 3rd and 4th arcs by using C7 and C1 o respectively as their 
radii. 

Before 

LJ . ... ... 
. . . . . . . 
. . . . . . . 
. . . . . . . 
. . . . . . . . . 

Step 7 • Working Drawing (Draw Arc) 

Step 8 - Merging Symbols to your Working Drawing 

The Merge command is used to attach a symbol file that has been previously created with discoverCAD to a 
drawing that is currently being created or edited, thereby allowing you to later access a symbol layer using the 
Symbol command (more on the Symbol command in the following steps). Select the Merge command in 
the FIie menu, and release the mouse button. You will then be prompted "Place drawing disk in drive #x:, 
then press Return." {where x represents the disk drive being used for the File Menu commands). Insert the 
disk that contains the symbol file SYM-127, and press Return. You will then be prompted "File name:". Type 
in SYM-127 (if you make a mistake while typing the filename, you may use the Delete or Lett Arrow keys to 
remove the error) and press Control a to enter the filename (depress the Control and a key at the same time). 
Once the symbol file has been specified, you may be prompted "Replace discoverCAD system disk 1 in drive 
#1; then press Return.". Replace the symbol disk with the discoverCAD system disk you may have removed, 
and press Return. 

The drawing you are currently creating or editing will now be redrawn on the screen, after which you can 
resume discoverCAD. Please note that any symbol file you merge to your drawing becomes a permanent part 
of the drawing; in this example the symbol fUe SYM-127 is now a permanent part of the drawing you are 
creating, and may be accessed at any time. You may notice that the symbols are not visible, but they are there 
located on layers 128 and 127. It is also important to note the size of your drawing file will grow as you add 
symbol files to it; be careful not to get your drawing file too large. Finally, please note that you may merge more 
than one symbol file to your drawing; simply repeat the instructions as listed above. 

Step 9 • Accessing your SymbOI Tables 

The Symbol command is used to copy a symbol from a layer to a drawing that is currently being created or 
edited. Select the Symbol command in the FIie menu. and release the mouse button. You will then be 
prompted "Copy symbol from layer number?"; type in 128, and press Return (if you press Return without 
entering a value for the layer, the system will exit the Symbol con ,mand). Next, you will be prompted "Copy 
symbol to layer number?"; type in 1, and press Return (again, If you press Return without entering a value for 
the layer, the system will exit the Symbol command). Finally, you will be prompted "Symbol Scaling?"; type in 1 
for the desired scale of the symbol in relationship to the drawing and press Return. If you press Return without 
entering a value for the scaling, a value of 1 will be used. If you wanted the symbol drawing scale to be 2:1, or 
twice as big, you would have typed In a 2. At this time, layer 128 will be displayed. 
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Step 9A - Transferring a Rectangular Symbol 

To select the symbol you wish to copy (in this example one of the rectangles you drew in step 3, click twice 
(C1. C2) In such a manner that the two coordinates you have specified will define a window around the desired 
symbol (i.e. rectangle). Having done this, click once more (C3) to Indicate a point of reference on the symbol. 
The system will now display layer 1. 

Before 

Step 9B - Placing the Rectangular Symbol 

Finish by clicking once (C4) where you would like the symbol to be placed, and it will be drawn with the point of 
reference placed at the coordinate you specify. If you wish to copy more symbols, simply repeat the above 
steps, otherwise simply press Return without specifying a layer number when prompted "Copy symbol from 
layer number?". See if you can use the Symbol command to copy the symbols {i.e. circles) you created on 
layer 127. Enter a value of 127 at the prompt "Copy symbol from layer number?" and press Return. Next, you 
will be prompted "Copy symbol to layer number?"; type in 1, and press Return. Finally, you will be prompted 
"Symbol Scaling?"; type in 1 for the desired scale of the symbol in relationship to the drawing and press 
Return. At this time, layer 127 will be displayed. 

Before 

. .. :c.1 ~ : : : : : : 
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Step 9C • Transferring a Circular Symbol 
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~ select the symbol you wish to copy (in this example one of the circles you drew in step 4), click twic7 (C1, 
C~) In such a manner that the two ~oor?inates you have spec~ie~ will defi~e a window around the desired 
symbol (i.e. circle). Having done this , chck once more (C3) to indicate a pomt of reference on the symbol . The 
system will now display layer 1. 

Before 

Step 90 • Placlng the Circular Symbol 

Finish by clicking once (C4) where you would like the symbol to be placed , and it will be drawn with the point of 
reference placed at the coordinate you specify. If you wish to copy more symbols , simply repeat the above 
steps , otherwise simply press Return without specifying a layer number when prompted "Copy symbol from 
layer number?" . 

As you can see from this example, discoverCAD allows you great flexibility when creating and recalling 
symbols. Now that you have completed this simple example, try experimenting to see what symbols you can 
create on your own. 
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Appendix C 
PRINT TUTORIAL 

discoverCAD allows you to print your drawing to a variety of Dot Matrix Printers from the Apple IIC, IIE, and IIGS 
computers. To do this you must use the Triple Dump screen dump program by Beagle Brothers, available from 
Hearlihy & Co. (Hearllhy #A110 - $31.95). Please note that the output you receive from the printer will not be 
quite as exact as the output a plotter would produce. 

Before you begin this procedure, please refer to the Triple Dump Owner's Manual to properly configure Triple 
Dump (DOS 3.3 Version only, side one) for your printer and interface card. Once all the proper connections 
have been made, follow the steps shown below to correctly print your drawing. 

Step 1 

Position your drawing on the screen exactly as you would like to see it appear on paper. You may want to use 
the Layer, zoom, and Pan commands to help position the drawing (see Screen Menu chapter). Please 
note that during the printing process there will be several screen prompts that appear at the bottom of the 
screen; you may want to position your drawing so that those prompts won't affect it. Also, please note that you 
should save your drawing using the Save command found in the FIie menu before using this command, as 
you will not be able to retrieve your drawing after printing if it has not been saved to disk. 

Step 2 

Highlight the Printer command in the Plot menu, and release the mouse button. You will then be prompted 
"WARNING: Wish to save drawing before printing? (Y/N)". If you press Y, the system will exit the Printer 
command, thereby allowing you the chance to save your drawing before printing. If you press N, you will then 
be prompted ''Replace discoverCAD disk(s) with Triple Dump disk, then press RETURN."; remove the 
discoverCAD system disk(s), insert the Triple Dump DOS 3.3 disk into the startup disk drive, and press Return. 
Please note that if you are using an Apple IIC or IIE, you should put the Triple Dump disk (DOS 3.3 version, 
side one) in the first disk drive. If you are using an Apple IIGS, you should put the Triple Dump disk (DOS 3.3 
version, side one) in the first 5.25" disk drive. In order to load a program from a 5.25" disk when using the 
Apple IIGS, you must have the IIGS Start Up SLOT set to SCAN in the Control Panel. You will then be 
prompted "WARNING: Wish to reboot system now? (YIN)". If you press N, the system will exit the Printer 
command. If you press Y, the computer will restart itself, after which time Triple Dump will be loaded and 
running (your discoverCAD drawing will still reside in the computer's memory). 

Step 3 

After approximately 1 O seconds, the Triple Dump banner will appear. You will then be prompted "<R> RUN 
TRIPLE DUMP, <0> QUlr'; type R to start the program, and the Triple Dump menu will appear on the screen. 
Next, use the directional arrows to highlight the TYPE command, and press Return (TYPE should now display 
DOUBLE HI-RES}. Now, press the Space Bar to view your drawing (this is what will be printed to your Dot 
Matrix Printer). Press the Space Bar again to return to the Triple Dump menu. At the top of the Menu you will 
notice the PRINTER and INTERFACE commands. Unless the configuration shown matches your current 
hardware setup, you will have to use the CHANGE PRINTER and CHANGE INTERFACE 
commands to specify the printer and interface you are using (if you are a IIGS user, select APPLE FIRMWARE 
for the INTERFACE selection). After configuring, select SAVE PRINTER INFO to save your hardware setup to 
the Triple Dump disk. Finally, select PRINT PICTURE and follow the prompts to print your drawing. 
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Step4 

If, after having printed your drawing it looks disproportionate (i.e. flattened circles), you may want to use the 
MAGNIFY X and MAGNIFY Y commands to achieve a better proportioned printout. In testing an lmageWriterll, 
we have found that X = 1 , Y = 2 works well. If you would like a white background with black lines versus a black 
background with white lines, change the NEGATIVE command from NO to YES. If you wish to remove the 
discoverCAD Menu Bar from the top of the printout, select the CROP PICTURE command and press Return. 
Next, press the T key. Now, press the right directional a1rrow key approximately twelve times until the Menu Bar 
is not inside the flashing rectangle called the CROP WINDOW, and press Return. Finally, select PRINT 
PICTURE and follow the prompts to reprint your drawing. 

Printing with discoverCAD from the IIGS to serial printers can also be accomplished via the FingerPrint GSi 
Screen Dump Utility Card, available from Hearlihy & Co. (Hearlihy #7444GS $127.50). Having installed the card 
per the FingerPrint Users Manual (make sure switch a is OFF, see page 9), the FingerPrint GSi accessories 
menu may be accessed from the discoverCAD screen as follows: First, move the arrow cursor into the far right 
corner of the menu bar. Then, while holding down the mouse button, press the red FingerPrint GSi activator 
button and release it. The FingerPrint menu will then appear, and may be utilized as described in the 
FingerPrint Users Manual. 

Printing with discoverCAD from the IIGS to parallel printers can also be accomplished via the ProGrappler 
Printer Interface Card, available from Orange Micro, Inc., 1400 N. Lakeview Ave., Anaheim, CA 92807 (714) 
779-2772. Having installed the card per the ProGrappler Operator's Manual, the ProGrappler accessories 
menu may be accessed from the discoverCAD screen as follows: First, move the arrow cursor into the far right 
corner of the menu bar. Then, enter the IIGS Desk Accessories program by pressing the Open Apple, Control, 
and Escape keys simultaneously. If the ProGrappler Printer Interface Card has been properly installed, the 
ProGrappler option should now appear in the Desk Accessory menu; highlight it and press Return. The 
ProGrappler menu will then appear, and may be utilized as described in the ProGrappler Operator's Manual. 
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App.endix D 
PLOT TUTORIAL 

discoverCAD allows you to plot your drawing to a variety of graphics plotters from the Apple IIC, IIE, and IIGS 
computers. Please note that the output you receive from the plotter will be more exact than the output a 
printer would produce. Before you begin this procedure, take the time to insure that the computer is able to 
communicate properly with the plotter. 

First, it may be necessary to configure your plotter for use with discoverCAD by setting the plotter's dip 
switches (these switches are usually found on the back of the plotter). Listed below are the dip switch settings 
for all of the plotters currently supported by discoverCAD. 

Apple Plotter; From left to right, while directly facing the back of the plotter, the pins are set OFF ON OFF OFF 
ON ON OFF ON. 

Roland pxy 880/980: From left to right, while directly facing the back of the plotter, the pins for BANK 1 are set 
D D D D U D D U D D, and the pins for BANK 2 are set D U D U D D U D D D, where D is clown and U is up. 

Please note that the Roland DXV 1100 plotter may be used in lieu of the DXV 880, and must be configured as 
follows: From left to right, while leaning over the front of the plotter, the pins for SW2 are set ON ON OFF OFF 
OFF OFF OFF OFF ON ON, and the pins for SW1 are set OFF OFF OFF OFF ON OFF OFF ON OFF OFF. 

ON ON 

-- Plotter - • • g~ SW2 SW1 

Roland DXY 1100 Pin Settings 

Houston Instrument PC695; From left to right, while directly facing the back of the plotter, the pins are set D u 
D D D U, where D is clown and U is up. 

Houston Instrument PMP40; No setting required (this includes any other HI DMP series A/8 plotters). 

Houston instrument PMP41: No setting required (this includes any other HI DMP series CID plotters). 

Hewlett Packard 7470: From left to right, while leaning over the front of the plotter, the pins are set o o o 1 1 o 
00. 

Hewlett Packard 7475; From left to right, while leaning over the front of the plotter, the pins are set o o o 1 o 1 
0 0 0. 
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d make sure to use the correct cable for the plotter and computer being used . Cables for Apple , 
Se~ond 'Houston Instrument , and Hewlett Packard plotters are available from Hearl ihy & Co. Attach the 
Ro ~~ ; iate cable to the plotter as described in the plotter's owners manua l, and to the computer as described 
~~fow~please no~e that in all cases you sh~u_ld connect the P!Otter cable to the computer before you turn the 
power on, otherwrse you may experience diffrculty when plottrng) : 

Apple UC; Connect the cable to Port 2 of the computer. 

Apple UE: Connect the cable to the serial card (see below). 

Apple UGS: Connect the cable to the Modem Port of the computer. 
Third, it may be necessary to configure your computer for plotting with discoverCAD by setting the computer's 
serial interface . Listed below are the settings for all of the computers currently supported by discoverCAD. 

Apple HC: Plotting from the Apple IIC with discoverCAD is accomplished using Port 2, and there is no setting 
required. 

Apple !IE: Plotting from the Apple IIE with discoverCAD requires the use of a serial card . If you plan to use the 
Apple Super Seria l Card configure it for use with a plotter as follows (please 11ote that it may be wise to jot down 
the current settings of the Super Serial Card before you change them) : First , set the dip switches on the card ; 
from left to right, while directly facing the card, the pins for BANK 1 are set OFF ON OFF ON OFF ON ON, and 
the pins for BANK 2 are set ON OFF OFF ON OFF OFF OFF . Next , make sure the Jumper Block if pointing 
downward to TERMINAL. Now, install the Apple Super Serial Card card in slot 2 of the computer. The IIE will 
remember you r new configuration, and use it in all subsequen t sessions with the computer. If you plan to use 
the Envoy serial card, see the Technical Notes appendix for its settings. 

Apple UGS: Plotting from the Apple IIGS with discoverCAD is accomplished using the Modem Port. Configure 
the port for use with a plotter as follows : First, enter the IIGS Desk Accessories program by pressing the Open 
Apple, Cont rol , and Escape keys simultaneously . Next , select the Control Panel option , then the Modem Port 
option (use the directional arrow keys to highlight the desired command). Now, set Device Connected to 
Printer , not Modem ; set Line Length to 80 , not Unlimited; set Baud to 2400 , not 1200 . Finally, press Return to 
save your configuration, then exit the Control Panel, then the Desk Accessories program . The IIGS will 
remember your new conf iguration, and use it in all subsequent sessions with the computer. Please note that 
plotting may also be accomplished using an Apple Super Serial Card installed in slot 2 of the IIGS (see IIE 
instructions above). · 

Once all the proper connections have been made, follow the steps shown below to correctly plot your 
drawing. 

Step 1 

Position your drawing on the screen exactly as you would like to see it appea r on paper (what you see on 
screen is exactly what will be plotted) . You may want to use the Layer, Zoom, and Pan commands to help 
position the drawing (see Screen Menu chapter) . Please note that you should save your drawing using the 
Save command found in the FIie menu before using this command in the event that there is a malfunction 
during plotting . Also , please note that if you will be plotting from the printer port it is wort hwhile to review the 
Slot Number command as outlined in the Introduction chapter or Technical Notes appendix (under 
Apple IIC Plus). 
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Step2 

Highlight the Plotter command in the Plot menu, and release the mouse button. Any subsequent output 
will now be sent to the plotter instead of the screen (when plotter is on, the command will have a check mark 
next to it In the Plot menu). Please note that this command will automatically shut itself off after the Redraw 
or Draw Layer command has been used. 

Step3 

Highlight the appropriate command for the plotter you are using (ex. Roland DXV) in the Plot menu, and 
release the mouse button. If the plotter you are using supports more than one paper size, you will be 
prompted for the paper size to use (ex. A or B); type In the desired paper size, and press Return. The system 
will then initialize the plotter for the plotting process. 

Step4 

Highlight the Redraw command in the Screen menu, and release the mouse button. Your drawing will now 
begin to plot on the plotter. 

Please note that had you constructed your drawing using several layers, and wanted to plot them separately 
using a different color pen for each one. you would have used the Draw Layer command instead of Redraw 
in Step 4. Then, after the first layer was finished plotting, you would reselect the Plotter command (please 
note that this command will automatically shut itself off after the Redraw or Draw Layer command has been 
used), use the Pen Number command to switch pens (see the Plot Menu chapter), and then plot the next 
layer, once again using the Draw Layer command. Simply follow this procedure until all the layers of your 
drawing have been plotted (see the Helpful Hints appendix for a more detailed explanation of this 
procedure). 
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Appendix E 
HELPFUL HINTS 

The Helpful Hints appendix contains any miscellaneous helpful hints, and is meant to serve as a quick 
reference for any questions or problems you may have regarding a specific command or operation. 

The commands or operations for which these suggestions pertain to appear in alphabetical order. 

Deleting Flies 

To permanently erase any unwanted discoverCAD drawing files on your drawing disk, you can use any utility 
disk capable of erasing a Pascal file. The utilities disk that comes with the Apple IIC and Apple IIGS is capable of 
erasing such a file; Apple IIE users will have to use one of the many utilities disks available. 

Dimensioning 

1) Occasionally you may find that a dimension you have created is extended from an entity other than the one 
you desired, especially when you are trying to dimension an entity in the midst of several other entities. You 
may find it useful to zoom in on the area before you try to dimension, thereby making it easier to distinguish 
between the entities. Also, make sure to place your clicks carefully when specifying the entity to be 
dimensioned (see diagram below). 

• not here! 
• 
click once here ... • and here ... 

Dimension Example 

Supposing you wanted to dimension the distance between the left end of the horizontal line and the top end 
of the vertical line as depicted above, you would place your clicks as shown. Had your second click been 
placed in the area marked "not here!" in the diagram, the system may have mistakenly dimensioned the 
distance between the ends of the horizontal line. If you are still having problems dimensioning the correct 
entity, you may have to remove the obstructing entities and replace them after you have finished the 
dimension. 

2) If you are having difficulty erasing a diameter, radial, or linear dimension, insure that you have selected the 
proper erase command for the type of dimensioning you are trying to erase by reselecting the command from 
the menu (i.e. you can't erase a linear dimension with Erase Radial Dim!). Also, remember that you must 
click at the lower left hand corner of the dimension text to erase the whole dimension; any other location will 
not work (it may take several clicks to locate this area). Finally, if you have the Snap Grid command in effect, 
turn it off; it may be causing your click to snap to the nearest grid dot instead of the dimension text. 
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Drawing Backup 

It is possible to backup your drawing disk by using the utilities disk that came with your Apple IIC, Apple IIE, or 
Apple IIGS computer. 

Draw Grid 

When drawing a grid, it is helpful to know exactly how and when to do so in order to save as much time as 
possible (i.e. depending on the density of the grid being drawn, it can take up to several minutes for a grid to 
be drawn) . By following this example, you can avoid wasting valuable drawing time: Suppose you are about to 
do some detailed work on your drawing, and have just performed the Zoom Window command to enlarge 
the drawing. Now you decide to display a fairly dense grid, and use the Draw Grid command with a size of 
0.0625 units, or 1/16" to do so. Later, having completed your detailed work, you decide to use Zoom Origin 
to return to the original scaling of your drawing, but before doing so, you wish to remove the grid currently 
displayed. You could use the Draw Grid command to remove the grid (and thereby waste time waiting for the 
grid to be erased), but there is a better way. Knowing that the grid is too dense (i.e. size = 0.0625) to be drawn 
at the original scaling, you proceed with the Zoom Origin anyway. You will then be prompted "WARNING: 
Grid too small. Press RETURN to continue."; press Return, and your drawing will be redrawn without the grid. 
Next, execute the Draw Grid command. Once again, you will be prompted "WARNING: Grid too small. Press 
RETURN to continue."; press Return, and the grid will have been erased without you having had to wait for it 
to be drawn. As a general rule of thumb, a grid size of 0.15 or smaller will result in a grid too dense to be drawn 
at the original scaling (i.e. Zoom Origin). 

Draw Line Angle 

When using the Draw Line command in conjunction with the Angle modifier, you may find it helpful to use 
the following example in order to insure that the line you draw is of the desired angle, direction, and length: 

First, use the Draw Line command with the Horizontal modifier to draw a line that will serve as a reference. 

Second, select the Angle modifier, and click once on the horizontal line you created in the step above (the 
angle of the new line will be based on its relationship to the horizontal line). 

Third, enter a value of 150 degrees for the angle and press Return. 

Fourth, click once where you would like the angular line to start. This click also theoretically defines the origin 
of the quadrant system as used in the step below. 

Fifth, click once where you would like the angular line to end. It is at this step that you will typically want to click 
in the quadrant where the angle (and resulting line) will lie. In this example, since the angle (i.e 150 degrees) 
lies in the 2nd quadrant, click in the second quadrant to define the length of the angular line (see Ex. 1 in the 
diagram below). Please note that had the line you used as a reference in the example above not been 
horizontal, you would have had to adjust the coordinate you specify to define the length accordingly. Ex. 2 in 
the diagram below shows the appropriate coordinate placement for an angular line of 150 degrees that used a 
45 degree line as a reference. 
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• 
2nd click 

1st click 

Draw Line Angle 

Dual Printer/ Plotter Configuration 

It is possible to have both a printer and plotter connected to your computer configuration at the same time, 
thereby allowing you the flexibility of either printing or plotting your drawing. 

Apple UC; Simply connect the printer to the printer port, and the plotter to the modem port. 

Apple HE; Connecting both a printer and plotter to your IIE configuration requires that you have two serial cards 
(use either the Apple Super Serial Card available from any Apple dealer, or the Envoy Serial Card available 
from Hearlihy & Co.). Place the card to be used for the printer in slot 1 of the IIE, and the card to be used for the 
plotter in slot 2 (see the Plot Tutorial for the dip switch settings of the card being used for plotting). Now, 
simply connect the printer and plotter to the appropriate serial card. 

Apple I !GS· Simply connect the printer to the printer port, and the plotter to the modem port (see the Plot 
Tutorial for the modem port settings). Please note that it is possible to install a serial card into slot 2 of the 
IIGS for plotting, thereby freeing the modem port for other use. Make sure that you set the dip switch settings 
of the serial card as described in the Plot Tutorial , then use the Desk Accessories firmware as follows to 
make the IIGS recognize your card: 1) To get the Desk Accessories Program, press the Control, Open Apple, 
and Escape keys simultaneously. 2) Press the Up Arrow or Down Arrow to highlight the Control Panel option, 
then press Return. 3) Press the Up Arrow or Down Arrow to highlight the Slots option, then press Return. 4) 
Press the Up Arrow or Down Arrow to highlight the Slot 2 option, then press the Right Arrow or the Left Arrow 
to change it to Your Card. Press Return to save the configuration, then Quit the Control Panel and the Desk 
Accessories menus. The IIGS will remember this configuration in all subsequent sessions. 

Edit 

You may have noticed that when discoverCAD saves a drawing to disk that it adds ".DATA" as a suffix to the 
drawing name. Please note that when using the Edit command to recall a drawing, you should not include the 
".DATA" suffix; simply type the name of the drawing exactly as you did when you used the Save command to 
store it to disk. 
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Merge 

When merging an existing discoverCAD II symbol file to y_our _wo~ing drawing, ~ar in mind that the symbols of 
the symbol me will appear on the same layer of you~ work.mg drawing as they _do m the symbol file. For exa~ple, 
had you created a symbol file called SYM128 In which the symbols are contained on layer 128, after merging 
SYM 128 to your working drawing, the symbols would appear on layer 128 of your working drawing, and remain 
there as a permanent part of the drawing. Please note that unless the layer on which the symbols appear is 
currently displayed (i.e. for this example layer 128), you will not see the symbol layer after merging. Once you 
have merged, you can use the Draw Layer command to review the symbol layer if so desired, and then the 
Erase Layer command to remove it from the display (Erase Layer will not actually erase the layer). 

Plotting 

When plotting your drawing, it is possible to achieve a multi-color and/or multi-line thickness plot. In order to do 
so, you must have first constructed your drawing using several different layers. For example, if you were 
creating an architectural floor plan, you could have the plot plan on layer 1, the electrical plan on layer 2, the 
furniture plan on layer 3, etc. Now, supposing you want to plot the floor plan a layer at a time, to achieve a 
multi-color and/or multi-line thickness plot follow this example: 

First, use the Erase Layer command to remove all layers except layer 1 (i.e. the plot plan) from the display. 

Second, plot layer 1 (i.e. the plot plan) as follows: 1) Select Plotter to direct the output to the plotter. 
2) Select the appropriate plotter type and enter the paper size being used. 
3) Select Pen Number and specify pen number 1. 
4) Select Redraw. Layer 1 will now be plotted using pen number 1. 

Third, plot layer 2 (i.e. the electrical plan) as follows: 1) Select Erase Layer to erase layer 1. 
2) Select Plotter to direct the output to the plotter (Plotter must be selected before each and every layer 
being plotted). 
3) Select Pen Number and specify pen number 2. 
4) Select Draw Layer and specify layer 2. Layer 2 will now be plotted using pen number 2 (please note that 
the layer will not be drawn to the screen). 

Fourth, plot layer 3 (i.e. the furniture plan) as follows: 1) Select Erase Layer to erase layer 2. 
2) Select Plotter to direct the output to the plotter (Plotter must be selected before each and every layer 
being plotted). 
3) Select Pen Number and specify pen number 3. 
4) Select Draw Layer and specify layer 3. Layer 3 will now be plotted using pen number 3 (please note that 
the layer will not be drawn to the screen). 

Assuming that the plotter had a different pen color or thickness for each pen number, you should now have a 
multi-color and/or multi-line thickness plot of your drawing. Please note that if the plotter you are using does 
not have multi-pen capability, it is still possible to achieve a multi-color and/or multi-line thickness plot by 
manually switching the pen for each layer plotted. 

Save 

When saving a new drawing file over an existing drawing file (i.e. you specify the same file name), please note 
that should the existing drawing file lie between two other existing drawing files on the disk, the new drawing 
will be placed at the end of the last file on the disk, and that the disk space occupied by the original drawing file 
will remain inaccessible, wasting valuable disk space. To remedy this problem, it is suggested that you save 
your work in a progressive order; by saving over the last file on the disk, you avoid the problem of having 
unaccessable blocks of disk space (i.e. do not save over a file that lies between two other files if at all possible). 
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Symbol 

1) To insure yQu are using the proper size work area when creating a symbol file from scratch, before 
beginning you may find it useful to execute the Zoom Origin command to set the system to Its original 
scaling. Then use the Draw Rectangle command to draw a box around the entire perimeter of the screen; 
that way, even if you zoom or pan during the course of creating the symbols, you will always know wheter or 
not you are within the proper drawing area. 

2) When transferring a symbol from a symbol layer to your working drawing, it is generally a good idea to 
transfer the symbol to a blank layer first; that way, if you have made an error (ex. the scaling of the symbol is 
incorrect), you may use the Erase Window to erase the mistake without erasing part of your drawing. 

3) When transferring a symbol from a symbol layer to your working drawing, you may transfer it to a layer that is 
not currently visible. The symbol will appear on the screen when you transfer it, but will actually reside on the 
hidden layer you have specified. If you issue the Redraw command after you have transferred the symbol, 
you will notice that the symbol no longer appears on screen (use the Draw Layer command to display the 

· layer that the symbol resides on to view the symbol). The above also applies when copying a symbol from a 
layer that is not currently visible. 

Zoom Window 

You may find that when using the Zoom Window command in conjunction with a grid, sometimes your 
drawing will not line up with the grid. If this is the case, activate the Snap Grid command, then use the Pan 
command to shift your drawing slightly; this should align your drawing with the grid. 
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Appendix F 
TECHNICAL NOTES 

The Technical Notes appendix contains any miscellaneous technical notes, and is meant to serve as a 
quick reference for any questions or problems you may have regarding a specific command or operation. 

The commands or operations for which these suggestions pertain to appear in alphabetical order, grouped 
accordingly under the headings Plotter Notes, Computer Notes, Drawing Notes, or Teaching 
Notes. 

PLOTTER NOTES 

Plottlng 

It is possible to plot from the printer port (slot 1) of your Apple computer instead of the modem port (slot 2) that 
discoverCAD usually uses. To change from slot 2 to slot 1, select the Slot command from the Apple menu, 
and type 1 when prompted for the slot number. Next, before you turn on the computer, connect the 
appropriate cable to both the plotter and printer port (slot 1). Finally, configure the printer port (slot 1) for 
plotting as follows. 

Apple UC: Boot the IIC Utilities Disk, and use the directional arrow keys to select the Configure the Serial Ports 
option found under Advanced Operations. Choose Set Port 1, then select I Know My PIN. Type 164/1111 
then press Return. This particular PIN will set the port to printer mode, 8 data bits with 2 stop bits, 2400 baud, 
no parity, no echo, no LF after CR, and no CR insert. Verify the above information, then press Return if its 
correct, or select NO if you have to reenter the PIN. Once you have entered the PIN correctly, use the Save 
command to store your configuration. Please note that you will have to reconfigure this port should wish to 
print from it later. 

Apple UE: Simply remove the serial card you are using from slot 2 and reinstall it in slot 1. 

Apple UGS: Enter the Desk Accessories program by pressing the Control, Open Apple, and Escape keys 
simultaneously. Use the directional arrow keys to select the Control Panel option, then the Printer Port option. 
Change line Length from unlimited to 80, LF after CR from Yes to No, and the Baud Rate from 9600 to 2400 
(all the other parameters should remain the same). Press Return to save the settings, then exit the Desk 
Accessories program. Please note that you will have to reconfigure this port should wish to print from it later. 
Now, when you are ready to plot, simply follow the Plot Tutorial as you normally would, the only difference 
being that you are using the printer port (slot 1) instead of the modem port (slot 2). 

If you experience difficulty when plotting your drawing as outlined in the Plot Tutorlal, the Hearlihy & Co. 
Tech. Support Staff can help. Review the following steps before you call, and be prepared to answer the 
questions outlined therein. 

1) Are you following the plot procedure as outlined in the Plot Tutorial? Does the Plotter command have a 
check mark next to it in the Plot menu? Did you select the appropriate command for the plotter you are using? 
Did you specify the appropriate paper size for the paper you are using? Make sure the Caps Lock key is 
depressed before you type the paper size. Did you select Redraw or Draw Layer to start the plotting 
process? Please take note of exactly what happens. 
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2) Have you configured the serial Interface of your computer as suggested in this manual? Remember that the 
Apple IIGS modem port must have been configured and saved via the Desk Accessories program, and that the 
serial card in the Apple IIE must have been configured via the dip switches on the card as described in the · 
Plot Tutorlal appendix. 

3) Did you make sure to connect the cable to both the plotter and computer before you turned the computer's 
power on? 

4) Are you using the correct cable? Some cables must be configured specifically for discoverCAD. 

5) ts the cable faulty? Did you perform a continuity test on the cable? Cable specifications are available in the 
Technlcal Notes chapter of this manual. Where did you purchase the cable? 

6) Did you run the plotter's seH test? If it fails to pass the seH test, you may have a plotter problem. Where did 
you purchase the plotter? 

Apple 41 O Color Plotter 

Although the Apple 410 Color Plotter has been discontinued, it will work with discoverCAD. Replacement pen 
points for the plotter are available from Hearfihy & Co. (see Hearfihy's Times Newsletters and Catalogs). See 
the Plot Tutorial appendix for more on the Apple 410 Color Plotter. 

Epson HI 80 Plotter 

To use the Epson HI 80 plotter with discoverCAD, equip the plotter with the Horizon Data H P emulation board 
(unfortunately this board has apparently been discontinued). Install the Apple Super Serial Card in slot 2 of the 
computer (configure the card as outlined in the Plot Tutorlal), and connect the plotter to the card via a 
standard straight through cable. To activate the plotter during the plotting process as outlined in the Plot 
Tutorial, select the HP 7470 command. Please note that this information has been provided by a 
discoverCAD customer, and may not have been tested by Hearlihy & Co. 

Hewlett Packard 7440A Color Pro Plotter 

To use the Hewlett Packard 7440A Color Pro plotter with discoverCAD, equip the plotter with the HP 7440A 
Graphic Enhancement Cartridge, available from Hewlett Packard (approximately $150.00). 

Hewlett Packard 7550 Plotter 

To use the Hewlett Packard 7550 plotter with discoverCAD, set the plotter to 2400 baud, no parity, hardware 
handshake, and remote mode. Install the Apple Super Serial Card in slot 2 of the computer (configure the card 
as outlined In the Plot Tutorial), and connect the plotter to the card via a standard RS 232 cable. To activate 
the plotter during the plotting process as outlined in the Plot Tutorial, select the HP 7475 command. 
Please note that this information has been provided by a discoverCAD customer, and may not have been 
tested by Hearlihy & Co. 
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Zerlcon PC 34/36 Plotter 

To use the Zericon PC 34/36 plotters with discoverCAD, set the plotter's dip switches as follows: from left to 
right, the pins are set DUD DD D, where o is down and U is up (this insures the plotter will run at 2400 baud). 
Connect the plotter to the modem port via one of the cables listed below. To activate the plotter during the 
plotting process as outlined in the Plot Tutorial, select the HI DMP41 command. Please note that this 
Information has been provided by a discoverCAD customer, and may not have been tested by Hearlihy & Co. 

To connect the Zericon PC 34/36 plotter to the Apple IIC computer, construct your cable using one of the 
following configurations. 

Cable Specifications 

4 Pin Telco Modular 

4GND 
3RD 
2TD 
1 (unconnected) 

6 Pin Modular 

4GND 
5DSR 
3RD 
2TD 
1,6 (unconnected) 

5 Pin DIN Connector 

2GND 
4TD 
5RD 
1,3 (unconnected) 

5 Pin DIN Connector 

2GND 
3DSR 
4TD 
5RD 
1 (unconnected) 

Listed below are the cable specifications for the plotters and computers supported by discoverCAD. Some of 
the configurations are standard per the manufacturer; others have been configured specifically for 
discoverCAD, and may not be appropriate for other applications. Check the table that follows for the number of 
the cable you should use with your plotter and computer (all cables are available from Hearlihy & Co.). 

Apple Apple Apple 
Plotter IIC IIE IIGS 

Apple410 2287 2289 2288 

HI PC Series 2281 2286 2282 

HI DMP Series 2283 2285 2284 

HP Series 2287 2289 2288 

Roland DXY Series 2287 2289 2288 
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The following abbreviations are used in detailing the cable specifications below. 

TD 
RD 
GND 
OTA 
DSR 
ATS 
CTS 
SCD 
SCTS 
DSRS 
DCD 
sec 

1 DTR 
2GND 
3DSR 
4TD 
SRO 

Transmit Data 
Receive Data 
Ground 
Data Tenninal Ready 
Data Set Ready 
Request to Send 
Clear to Send 
Secondary Carrier Detector 
Secondary Clear to Send 
Data Signal Rate Selector 
Data Carrier Detect 
Serial Communication 
Channel 

Note: Diagram depicts face of cable 

Five Pin DIN Connector 

This diagram depicts the Five Pin DIN Connector as used in the cable configurations that follow. 

000 
000 

0 © 

1 Handshake Out 
2 Handshake In 
3 TD Minus 
4GND 
5 RD Minus 
6 TD Plus 
7To DCD on SCC 
8 RD Plus 

Note: Diagram depicts face of cable 

Eight Pin DIN Connector 

This diagram depicts the Eight Pin DIN Connector as used in the cable configurations that follow. 
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I I 

1 (unconnected) 
2TD 
3RD 
4GND 
5DTR 
6 (unconnected) 

Note: Diagram depicts face of cable 

RJ12 Six Pin Modular Plug 

This diagram depicts the RJ12 Six Pin Modular Plug as used in the cable configurations that follow. 

Cable e2201: 

Cable e22s2: 

RJ12 Six Pin Modular Plug 

1 (unconnected) 
2TD 
3RD 
4GND 
SDTR 
6 (unconnected) 

RJ12 Six Pin Modular Plug 

1 (unconnected) 
2TD 
3RD 
4GND 
5DTR 
6 (unconnected) 

Five Pin DIN Connector 

SRO 
4TD 
2GND 
3DSR 
1 (unconnected) 

DB-25P Connector 

2TD 
3RD 
7 GND 
4 & 20 RTS & DTR 
1,5,6,8-19,21-25 
(unconnected) 

Please note that on the DB-25P connector 4 RTS and 20 DTR are jumpered . 

Cable #2283: 

Cable #2284: 

DB-25S Connector 

2TD 
3RD 
4RTS 
7GND 
1,5,6,8-25 (unconnected) 

DB-25S Connector 

2TD 
3RD 
4RTS 
7GND 
1,5,6,8-25 (unconnected) 
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Five Pin DIN Connector 

SRO 
4TD 
3DSR 
2GND 
1 (unconnected) 

DB-2SP Connector 

2TD 
3RD 
4RTS 
7GND 
1,5,6,8 -25 (unconnected) 



cable 122as: 

Cable #2286: 

Cable #2287: 

Cable #2288: 

DB-25S Connector 

1 (unconnected) 
2TD 
3RD 
4RTS 
7GND 
1,5,6,8-25 (unconnected) 

RJ12 Six Pin Modular Plug 

1 (unconnected) 
2TD 
3RD 
4GND 
5DTR 
6 (unconnected) 

DB-25P Connector 

2TD 
3RD 
6DSR 
7GND 
20 DTR 
1,4,5,8-19,21-25 
(unconnected) 

DB-25P Connector 

1 GND 
2TD 
3RD 
4RTS 
SCTS 
7GND 
BGD 
12SCD 
13 SCTS 
20 DTR 
23 DSRS 

Eight Pin DIN Connector 

5 RD minus 
3TD minus 
2 Handshake in 
4GND 
1,6-8 (unconnected) 

Eight Pin DIN Connector 

5 RD minus 
3TD minus 
4GND 
2 Handshake in 
1,6-8 (unconnected) 

Five Pin DIN Connector 

SRO 
4TD 
1 DTR 
2GND 
3DSR 

DB-25P Connector 

1 GND 
2TD 
3RD 
4RTS 
SCTS 
7GND 
BCD 
12 SCD 
13 SCTS 
20DTR 
23 DSRS 

Please note that pins 6,9,10,11,14,-19,21,22,25 are unconnected on either cable end. 

Cable #2289: DB-25P Connector 

2TD 
3RD 
7GND 
20DTR 
1,4,5,6,8-19 ,21-25 (unconnected) 
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Eight Pin DIN Connector 

5 RD Minus 
3TD Minus 
4GND 
2 Handshake In 
1,6-8 (unconnected) 



COMPUTER NOTES 

Laser 128 Computer 

discoverCAD will work on the Laser 128 computer (it's Apple IIC compatible), however, depending on the 
ROM version installed in your unit, you may encounter difficulty when plotting (lose of mouse control may 
result after you select the Plotter command from the Plot menu). If this problem occurs, simply use keyboard 
control to complete the plotting process. discoverCAD also runs on the Franklin 500 and 2100 computers, but 
has not been fully tested. 

Apple II+ Computer 

discoverCAD will not work on the Apple 11+, due to the fact that the computer lacks the Double Hi-Resolution 
display required by the software. 

Apple IIGS Computer 

If you are running discoverCAD on the Apple IIGS and weird things are happening, most likely your problem is 
due to a misunderstanding of how the Apple IIGS operates with discoverCAD. Reread the Introduction 
chapter of this manual, paying special attention to the Startup section. Apple IIGS users should never 
remove the 3.5" discoverCAD system disk drive from the first disk drive, and should always use a drive other 
than the first disk drive for all FIie commands. 

If you can't get a printout using the Triple Dump program on the Apple IIGS, either by itself or with 
discoverCAD, most likely your problem is due to an incorrect interface selection. When first configuring Triple 
Dump for use with the Apple IIGS, make sure to select APPLE FIRMWARE as the interface. If APPLE 
FIRMWARE does not appear on the interface list, it will be necessary for you to obtain an upgrade of the Triple 
Dump program by sending your original disk, along with a letter explaining that you need the APPLE 
FIRMWARE interface for use on the Apple IIGS, to Beagle Brothers Micro Software, Inc. (they should upgrade 
it for you at no extra charge). 

Apple IIC Plus Computer 

discoverCAD is capable of running on the newly released Apple IIC Plus computer. Listed below are the 
specifications necessary to use discoverCAD effectively on the Apple IIC Plus. 

Compatibility; Every discoverCAD command has been successfully tested on the Apple IIC Plus for 
compatibility. The procedures for operating each command is correct as stated in this manual, unless stated 
otherwise in the notes that follow. 

Clock Speed; The Apple IIC Plus has the option of running at 1.0 MHz (normal) or 4.0 MHz (fast); it is 
recommended that you use the faster clock speed (i.e. 4.0 MHz) with discoverCAD. 

Display: The Apple IIC Plus has both a RGB and composite output jack; it is recommended that you use a 
monochrome composite monitor with discoverCAD. If you use a color composite monitor, be sure to set it to 
monochrome display for the best display. 
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prjyes; The Apple 11c Plus has one buiH in ~-5" disk drive, designated as Slot 5, Drive 1 (please note that the 
drives for the Apple 11c Plus are _numbered m the same m_anner ~s. the Apple IIGS). You may also connect 
additional 3.5" and 5.25" disk dnves to the IIC Plus by daisy chammg them together, as with the Apple IIGS. 
use the discoverCAD Drive command to access the drives as follows: #1 is the internal 3.5" drive, #2 is the 
1st external 3.5" drive, #3 is the 1st 5.25" drive, and so on. 

~ As with the original Apple IIC, configuration of the Apple IIC Plus printer and modem ports is done via a 
utilities disk. However, the printer and modem port pin outs are similar to those on an Apple IIGS (both use an 8 
pin connector). 

prjntjng: To print from the Apple IIC Plus with discoverCAD, follow the printing procedure as outlined in the 
Print Tutorial appendix as you normally would, however, make sure to remove the discoverCAD System 
Disk from the internal 3.5" disk drive before you reboot (step 2 of the print tutorial). Otherwise, the Apple IIC 
Plus will reboot discoverCAD from the internal 3.5" disk drive instead of Triple Dump from the external 5.25" 
disk drive. 

Plottjng: Before plotting from the Apple IIC Plus with discoverCAD, take the time to insure that the computer is 
able to communicate properly with the plotter. First, it may be necessary to configure your plotter for use with 
discoverCAD by setting the plotter's dip switches (see the Plot Tutorial appendix for plotter settings). ~ 
Second, make sure to use the correct cable. Since the pin outs and connectors for the Apple IIC Plus are the 
same as the Apple IIGS, you may use the same cable specHications for the plotter (see the section on cable 
specifications in this appendix). Please note that these cables are available through'Hearlihy & Co. Third, 
attach the cable to the plotter as described in the plotter's owners manual, then to the computer as described 
below. To plot from the modem port, simply connect the cable to the Apple IIC Plus modem port, then follow 
the plotting process as detailed in the Plot Tutorial appendix. To plot from the printer port, connect the 
cable to the Apple IIC Plus printer port, then use the Apple IIC Plus Utilities Disk to configure the printer port as 
follows: select Setting Serial Ports, then Set Printer Port. Use the directional keys to change the settings; 
Device Connected is Printer, Line Length is 80, Add LF after CR is No, Echo is Yes, Baud is 2400, Data Stop 
Bits is 8/1, Parity is None, and XON/XOFF Handshake is No. Save the port settings, then follow the plotting 
process as detailed in the Plot Tutorial appendix when you are ready to plot. Please note that you must 
reconfigure the printer port to its original settings if you wish to print from it. Also, please note that if you will be 
plotting from the printer port it is worthwhile to review the Slot Number command as outlined in the 
Introduction chapter or Technical Notes appendix (under Apple IIC Plus). 

Color Monitor 

discoverCAD will work on a color monitor utilizing a RGB board, however, the resolution will not be quite as 
clear as it would be with a monochrome monitor. Set your color monitor to monochrome mode if it should have 
such a feature. 

Envoy Serial Card 

The Envoy Card is 100% Apple compatible, and may be used in lieu of the Apple Super Serial Card when 
running discoverCAD. Please note that there are several minor differences between the two cards. 

Pip Switch Boxes; The numbering of the dip switch boxes on the Envoy card is reversed (i.e. the left box is 
number 2, the right box is number 1). However, the actual dip switch numbering is the same. 

pjp Switches: There are 8 switches per box on the Envoy card, vs. 7 switches per box on the Apple Super 
Serial Card. Set the eighth switch of both boxes to off (i.e. down). 
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Jumper Block: Instead of using a jumper block to designate what type of output the card will handle (i.e. 
terminal or modem), the Envoy card has a separate header for each type of output. When using the Envoy 
card with discoverCAD, attach the ribbon cable to the header mar1<ed "Printer'' as described below. 

Rjbbon Cable: When attaching the ribbon cable that comes with the Envoy card to the printer header, make 
sure that the small arrow on the plug end of the cable points toward the card, and faces the front of the 
computer. Also, the colored edge of the cable should be on top of the cable once connected to the header. 

SW-2 S'vr'-1 
MODEM 
HEADER 

PRINTER 
HEADER 

I~~~~~~~~ 11 ~~~~~~~~ I I 
Note: Black shows switch position .__ ____ __, 

I I I I 

00 
00 
00 
00 
00 
00 
00 
00 
00 
00 
00 
00 
00 
00 
00 
00 DI.__________. 

I 

Envoy Serial Card 

Peripheral Cards 

M~P .... I ----1 PL AST IC 
CONNECTOR 

I I ENVOY 

I 
RIBBON CABLE 

Certain peripheral cards are not compatible with discoverCAD, and may cause problems when you boot the 
software. Among the offending cards we have found are any modem card installed in slot 2 of the Apple IIE or 
Apple IIGS, or connected to the modem port of the Apple IIGS, and the Microsoft Premium SoftCard installed 
in the Auxiliary slot of the Apple IIE. Should one of these peripheral cards cause a problem, or you suspect 
that another card may be causing a problem, simply remove the card before you boot. 

Printing 

If you experience difficulty when printing your drawing with Triple Dump (i.e. you lose your drawing), it could be 
due to a speed up card you may have installed. Both the Speed Demon and Transwarp cards, as well as 
several other speed up cards, display a logo on screen whenever you warm or cold boot the system, 
effectively erasing your drawing in memory. If this problem occurs, simply remove the offending card before 
you print. 

RAM Card & Network versions 

discoverCAD is not currently available in a RAM card or networ1< configuration. Watch Hearlihy's Times 
Newsletters and Catalogs for future update and upgrade information. 
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DRAWING NOTES 

command Selection 

Please note that when selecting a command from a menu, you should give the system enough time to load 
the command before you proceed, as it is possible to incur a system error requiring you to reboot the system 
should you do otherwise . 

compatlble Software 

oue to the unique manner in which the discoverCAD database is designed, there are no other programs that 
will interface with discoverCAD. 

Disks 

Make sure to never write protect your discoverCAD system disk(s}; you may receive a system error should you 
do so. 

3.5" vs 5.25" Disk 

The advantage to using discoverCAD on one 3.5" disk vs. two 5.25" disks lies in the fact that the 3.5" disk is 
more durable and less likely to lose information, or be damaged by a student than the 5.25" disks. Also, you 
will find that the 3.5" version of discoverCAD is a little quicker than the 5.25" version since there is less disk 
access time (i.e. one disk vs . two}. 

Dlsplay (Apple IIE} 

If your display appears to have lines running across it when you first boot the system, check to make sure you 
have installed the Double Hi Res jumper block on the Apple Extended SO-Column Text Card . 

DOS 

discoverCAD is written in UCSD Pascal 1.3, and operates under the Pascal operating system . 

Draw Grid 

You may find that when displaying a grid at extreme magnifications (i.e. you are zoomed in at an extreme ratio}, 
the grid does not start at the bottom of the screen as it normally does, but rather at some point else between 
the top and bottom of the screen . If this is the case, execute the Redraw command, and the grid should be 
redrawn starting at the bottom of the screen. 
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Erasing 

When using any of the Erase commands (ex. Erase Line), you may find that occasionally the system will 
erase an entity other than the one you have specified. When this happens, it is usually due to the fact that the 
entities are too close together, and the system gets confused as to which entity you want to erase. 
discoverCAD searches the database starting with the entity last entered; if it finds an entity of the same type 
you are trying to erase that is close to where you have clicked, it will erase that entity instead of the intended 
entity. Should this problem occur, simply use either the Zoom In or Zoom Window command to enlarge 
the drawing, thereby making it easier to select the entity to be erased. 

Redraw Speed 

It is possible to speed up the Apple IIC, Apple IIE or Apple IIGS computers in order to get faster redraw and 
grid display times with discoverCAD. Apple IIC users can use the Zip Chip to increase the clock speed from 
1.02 MHz to 4 MHz. Apple IIE users can use the Zip Chip to increase the clock speed from 1.02 MHz to 4 MHz, 
or the Transwarp Card to increase the clock speed from 1.02 MHz to 3.6 MHz. Apple IIGS users can use the 
Zip Chip to increase the clock speed from 2.8 MHz to 4 MHz, or the Transwarp GS to increase the clock speed 
from 2.8 MHz or 7 MHz. Please note that the Zip Chip is available from Zip Technology. The Transwarp Card is 
available from Hearlihy & Co. 

Resolution 

If you are experiencing poor screen resolution using discoverCAD on the Apple IIE, make sure that the 
Double Hi Res Jumper Block is installed on the Apple Extended BO-Column Text Card. 

Saving Drawings 

Depending on the complexity of the drawings you are trying to save, it is reasonable to assume that you can 
store 15 drawings on one 5.25" disk, and 40 drawings on one 3.5" disk. 

Scaling 

discoverCAD's scaling is calibrated generically, so that one grid space can be equated to anything from one 
millimeter to 1 mile or more. For example, if you desired to draw in inches, select the Draw Grid command 
from the Screen menu, then press Return without entering a value for the size. Conceptually, the spacing 
between each grid dot would represent one inch. If you had specified 0.25 as the grid size, the spacing 
between each grid dot would represent 1/4 inch. 

Screen Size 

When drawing with discoverCAD, the size of the screen is restricted due to the fact that the computer is limited 
as to the maximum number it may represent. You may find when pushing discoverCAD to its limits during the 
course of panning or zooming that the resultant display may not be accurate due to round off error. 

Stanup 

If, upon starting the discoverCAD system on the Apple IIE the error message "80 column card not installed" 
appears, make sure you have properly installed the Apple Extended BO-Column Text Card in the Auxiliary slot; 
discoverCAD cannot function without it. 
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TEACHING NOTES 

CADPAKs 

When purchasing a discoverCAD CADPAK, it is not possible to get part of the set as 3.5" disks for the Apple 
IIGS, and the rest as 5.25" disks for the Apple 11c or Apple IIE (CADPAKs are not sold in mixed sets). However, 
by using our Format Exchange Policy, you can receive a 3.5" disk for each set of 5.25" disks returned to 
Hearlihy & Co., at a cost of only $10.00 per system. 

lnstructlonal Materlal 

For additional support material regarding discoverCAD, refer to Hearlihy's Times Newsletters and Catalogs for 
our discoverCAD courseWARE product. Written by three Engineering Graphics professors from Purdue 
University, a lot of time and effort has gone into making this a product you and your students can benefit from. 

Software Demonstration 

To effectively show discoverCAD to all of your students at the same time, you might consider the following 
suggestions. If you are trying to demonstrate discoverCAD to all of your students at the same time, you could 
use a computer projection panel (available from Hearlihy & Co.). Or, if you are trying to teach or show the 
program on an individual basis, Hearlihy & Co. has published a discoverCAD courseware program. Designed 
to be used with little or no additional instruction, you will find that the discoverCAD courseWARE program will 
get your students up to par quickly. 
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